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This handout contains screen shots of confidential and proprietary information
for view only. It shall not be copied or shared for anything other than its intended
purpose as a training device for the County of San Diego, Mental Health
Management Information System.
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CONFIDENTIALITY

HIPAA regulations mandate that all client information be treated confidentially.

Access to CCBH is based on your position and your job classification. You will have the
access you need to complete your job duties. This can include access to clients in your
Unit/SubUnit or may include full client look up. Remember — with more access comes
greater responsibility regarding confidentiality!

You are not to share passwords with other staff. The Summary of Policy you signed
before receiving your access to CCBH included your agreement to this directive. You
are still responsible if someone with whom you have shared your password violates
confidentiality!

The MIS unit investigates any suspicions regarding sharing of passwords.
Consequences are up to, and may include termination.

Do not open any active client charts unless instructed to do so, or if it is required to
complete your job duties. “Surfing” clients is a blatant breach of confidentiality.

Remember you are personally and legally responsible for maintaining confidentiality.
Take it seriously.

Do not leave your computer unlocked with client data on the screen for others to access
or view while you are away from your desk. Lock your CCBH session before leaving
your computer.

When printing, make sure you are printing to a confidential printer, and pick up your

paperwork quickly. Leaving printed Protected Health Information (PHI) out is also a
confidentiality violation.

Play it safe — keep in mind how you would want your own PHI handled!
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CCBH SOFTWARE BASICS

CCBH IS ACCESSED THROUGH CITRIX (Cerner):
Go to https://cosdca.cernerworks.com
(Save this to your favorites or create a shortcut for your desktop)

“TAB TO TRAVEL”: Get in the habit of using your “Tab” key. Using the “Tab”
assures that you are directed to all required fields and that the information you
input is actually captured by the system.

RIGHT CLICK: When there is no obvious way to add information into a field, right
click in the space to view your options.

FILTERS/RADIO BUTTONS: Check these first and make sure they are on “all”
when searching the database.

MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end
of a field, it means there is a “Search Screen” that you can pull up to find
information for that field. You do not have to use them, but they are there if you
need them.

REQUIRED FIELDS are in red or blue: They must be filled-in to save and final
approve information.

OPTIONAL FIELDS are in white: Information may be added, but is not required
to final approve the Assessment. Keep in mind - just because you have
completed all the fields required to final approve the form, does not mean
you have completed a thorough clinical assessment. Documentation
standards have not changed.

CLOSED FIELDS are in gray: Nothing can be added in these fields.
CASE SENSITIVE:

1. Passwords — if you receive an error message for “Invalid Password”, check
to make sure you are using the appropriate upper and lower case letters
when typing. After a third attempt with an invalid password, the system will
lock your session and will require contacting the Optum Support Desk
(1-800-834-3792) to unlock it.

2. Table Searches — when searching within a table, be aware that descriptions
or IDs are case sensitive. If you do not use the correct upper or upper and
lower case entry, the search will not take you to the desired table value.
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MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access
the same information in multiple ways. We have included screenshots and
directions in this document to guide you through the system.

LOCKING YOUR SESSION: For security purposes, you must lock your session
any time you step away from your computer. This packet explains the various
ways to lock your session.

@ Note: Locking your session is best used for short times away from your computer.
CCBH will log you out after 60 minutes. There is a chance of losing work that has not
been final approved or saved if CCBH logs you off.

WHEN YOU GO BACK TO YOUR PROGRAM: You are learning how to enter
assessments in the “SDC Train CCBH” environment during this training, which
is for practice purposes only. It is important to enter all of your assessment
information in the “SDC Live CCBH” environment when you return to your
program.

For password resets/menu issues: Call the Optum Support Desk. You may also
call if you need your “SDC Live CCBH” environment password or menu set up.
Their contact information is:

Optum Support Desk
1-800-834-3792

Reminder:

Menu access is set according to job title/functions. The menus you have at your
program may look different than menus shown in the screen shots in this packet.
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CCBH SPEAK

Assessment

In CCBH, anything that is not a Client Plan or a Progress Note is
considered an “Assessment.” So, in CCBH Speak, forms such as the
Discharge Summary, Outcome Forms, and Demographic Form are
considered “Assessments” as well as the actual clinical assessment
forms.

Assignment

Opening/Closing a client to a specific program (Unit/SubUnit/s) and to
a specific server.

Clinician’s
Homepage

A “page” that provides the Clinical servers at each open assignment to
view client/s and client information for the identified caseload in one
screen. This includes client look up, caseload listing, appointments,
task/s to do, notifications, and other client information present in the
EHR.

Collateral
Server

Co-Staff providing a service (i.e. co-facilitator). Used when more than
one staff is providing a service to the same client, on the same date
and at the same time as server.

Demographic

A client is entered into the EHR by the completion and final approval of
the demographic form. A client may not be opened to
assignment/program unless the demographic form is entered,
completed, and final approved.

Final Approve Locks the completed assessment. Prevents editing/deletion of
assessments.

SAIl - Single Primary server identified based on primary unit program set up. This

Accountable staff will be listed as the primary contact for the client in the system of

Individual care for purposes of coordination of care.

Scheduler A program within the EHR that allows for scheduling of client service

events and ongoing appointment/s. This information will populate to
the Clinician’'s Homepage once entered into the EHR through the
Scheduler menu.

Service Code

Procedure Code. The code data entered into the EHR for the purpose
of claiming a service activity.

Server Staff providing a service activity.
Unit The Physical Location of a program, or legal entity.
Sub-Unit The specialized set of services offered within a Unit (i.e. population,

funding sources, etc.).
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The first Citrix (Cerner) password you ever receive is considered a temporary password.
For security reasons, you will be prompted to change your password on your first log in.
To do so after the initial login, click “Change Password” when first logging in to Citrix
(Cerner).

PASSWORD CHANGES

Citrix (Cerner) Password

= Cerner

! Cﬁange pas‘rswdrd...' ' L
Log Off

0 Next, follow the prompts to change your
User name: COSD_CA\anasazigen10
0ld password: | paSSWOFd .

Confirm password:

oK Cancel

CCBH Password

You are prompted by the system to change your CCBH password every 90 days.
However, if you feel that someone has learned your password, for security reasons you
should change it immediately. There are two ways to do this:

External View

@ View From the External View, go to the “File” tab,
then “Security” menu and select the “Change
Password” option. Follow the prompts to

| change your password.

—L

Clinician’s Homepage mG) View

From the Clinician’s Homepage, go to the SP———

‘File Tab’. Select the “Security” menu, and E;ao'”” »

then select the “Change Password” option. | s Lo

Follow the prompts to change your password. Ejl ety [53g] crange posswors @
‘ﬂ| Abaut CC
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LOCK CCBH SESSION

For security reasons, the expectation is that you will lock your CCBH session any time
you step away from your computer. There are two ways to do this.

Clinician’s Homepage

From the Clinician’s Homepage, go to the “File Tab” and select the “Security” drop down
menu, then select “Lock Session” button.

Home View
| —

©) Lock Session?
Open Perform Security Actions

O Lock @
Menu » 1l

||J_“:| Change Password
=

(gl

o Lock CCBH session for STAFF, CLINICAL?

- Security 3
1

WARNIMG: Any reports currently running that are output to screen will

display on the terminal when completed. User should lock the terminal
About CCBH @ using Windows functionality.

|j Freferences ‘ |)g Exit Application |

External View

From the External View, go to the “File” tab and select the “Security” drop down menu, then select
the “Lock” option.

E Security . orm Security Actions
il
[ | J-] Lock @
|ﬂ About CCBH 1
[

You will be prompted to enter your password to unlock the session.

9?@ This CCBH Seszion has been locked

Thiz CCBH Session iz in use and has been locked.

Only the Staff member who locked this zezsion may unlock it

Fazzword: || |

| k. | | Cancel
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EXITING THE APPLICATION

EXITING CCBH: To make sure you do not accidentally create a “ghost session”
and lock yourself out of accessing CCBH, you must exit in the following manner:

Clinician’s Homepage

1. Go to the “File Tab” menu in the top left-hand corner of your screen.
2. Select the “Exit Application” option.

- ol
Eg Open Recently Opened Views

— 01 Staff Maintenance

Menu * | 02 Client Assignments Maintenance
F

®

g Preferences || 3 Exit Application

External View

e Go to the “File” menu in the top left-hand corner of your screen.
e Select the “Exit Application” option.
e Repeat this step for any open external view window.

B
R ity O d Vi
EO_‘;; OI’JEH ecently Upene ews

— 01 Staff Maintenance

Menu * | 02 Client Assignments Maintenance

®

il Preferences it Application
Pref A, Exit Applicat

¥

You risk being locked out of CCBH if you do not exit in the manner described
above!
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CLINICIAN’S HOMEPAGE TERMINOLOGY

Identifying Terms Used on the Clinician’s Homepage

Clinician’s Homepage:
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status
at a glance.

File Tab

The “File Tab” acts as the menu. It can be used to exit “ Home | View
the application, set preferences, access the external o O ctar Claar
view, or see recently opened views.

Tabs:
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage.

» : :
Home , m Home Client View

F s P o~ e < -y

e There are four tabs: “File”,
“Client” and “View”.

@ Note: The “Client” Tab will only be available if the “Client Panel” is set with a client
name.

Ribbon:
e The “Ribbon” is an object that is comprised of various buttons.

File Hame View
y lﬂﬂstaff Clear ) ':' _“EECIient Clear ':. [ Services f'& System
& ly Hom e % = Show Client Panel L+
Staff Refresh Client Add
Search Staff Panel | Search Client
CHaff Entitur T liamt Entite “romom Matac aDracs
Buttons:
@ » . . . . .
e The “Buttons” are individual selections that can be clicked on to perform various
functions.
qHame‘/ViEW / / / / / /
E y ﬂﬂstaff Clear C_\" _E]CIlent Clear GBSEI'\!’ICES f& System eRx not available @ LI m
ly Home "5"" b = Show Client Panel |"' . |
Staff Refresh Client Pharmacy Break The Layout and
Search Staff Panel  Search \ Directory Glass Filters ~
Staff Entity Client Entity Group Motes ePrescribing Status Pharmacies Break Glass Panel Options
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Staff Panel:
y
W CLINICAL STAFF

Caseload
e The “Staff Panel” will have your o

name. The “Staff Panel” consists
of three panes. The “Caseload”

Pane, the “Scheduled Services”
Pane, and the “Shortcuts” pane.

Type | Mame

SAL
I Caseload

CLENT. FAKE
DEER. RAIN

FAN. CEILNG
KITE. FLYRG

Caseload | Scheduled Services  Shortouts

e Clients will only display under the “Caseload” pane if they have been assigned to
you. Admin staff are not able to carry a caseload.

Caseload || Scheduled Services | Shortouts

e The “Scheduled Services” pane displays your scheduled service events for that
individual day. Admin staff do not provide services.

Cazeload  Scheduled Services | Shortcuts

e Any shortcuts set up in the External View will display under the “Shortcuts” pane.
Shortcuts will not be set up during this training.

Client Panel:

1_1

“ FAKE CLIENT

FaceSheet | Pre-Intake Assessments Assignments ;) Diagnoses - Assessed 08/23/2022 Substance Abuse  Insurance Coverages  Services  Scheduled Services  Authorizations

o The “Client Panel” displays information about the client that you selected. The
“Client Panel” consists of “Client Panes”. You may access the information
contained in those panes by clicking on each pane. The information contained in
these areas is pulled from assessments, or forms, in CCBH.

-10 -
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CLIENT SEARCH
Clinician’s Homepage
e Select the “Client Search” button

S

Home View

g_, £ staff Clear T‘N @3 | Client Clear "
Wy Home A [ Show Client Panel +

Staff Refresh Client Add

Search Staff Panel | Search Client

Staff Entity Client Entity |

e The “Client Lookup” window will open

H Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search

Client Search Parameters

Caze # Ijl Sort Marme |
Lastl | First| | DOB | i | Thiu | Defaut |

Hlias Last | | First | | Sex - sSH[———— | fear |

Client Search Results
Marne First  Last Case# 5. Eth... DOB 53N Prim Unit ID Prim Uni,., | Prim SubUn... Prim SubU... External ... SAIID

Search

SALN...

There are no items ko show,

There are several different ways to search for a client from this window:
¢ If you have the client’'s case number, or Social Security number, you can simply
enter it in the “Case#” or “SSN” field and select “Search”.
e By “Sort Name”: Enter the client’s sort name in the LAST NAME, FIRST NAME
format, then select the “Search” button. (The “Sort Name” is the client’'s name as
formatted when first entered into the CCBH system):

K Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search

Client Search Parameters -

Case # l:[| Sort Name : Search
Last First poe |/ / Thu| /7 Default
Alias Last First V Sex |- v SSN '_'_'— | Clear

Client Search Results

Name First  Last Case# S... Eth... DOB SSN - Prim Unit ID Prim Uni... Prim SubUn... Prim Subl... External... SAIID  SAIN...

There are no items to show,

o111 -
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e |f the Sort Name you’ve entered is in the system, it will be displayed in the “Client
Search Results” area, as in this screen shot which exemplifies a search done for
fictional client sort name, “PIE, APPLE”:

| click on the search button to perform a search for client records based on the criteria in the top section.

Client Search 7
Client Search P ters
casegl:l I Sort Name |PIE, APPLE [ search |
Last| | First DOB ‘ // | Thy | Defaul |
| | s R s ™ ey [
Client Search Results
Name First Last Case# 5., Eth... |DOB  |SSN  Prim UnitID | Prim Uni... Prim SubUn... Prim Subll...  External... SAIID |SAIM...

PIE, APPLE ~ APPLE PIE RN 1] 0

@ Note: Double Clicking on the client's
name will launch the Client Panel.

e |f the Sort Name you entered is not in the system, you will receive the following
stop message:

@ Mo Clienks were found using the current search criteria

e This does not mean that the client is not in CCBH. Rather, you may not have
entered the sort name exactly as it was formatted when the client’s information
was first entered into the CCBH system. For this reason, you should search by
other criteria such as:

@ Note: Before beginning another type of search, select the “Clear” button to
reset the search criteria. Cleat

¢ In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling
and in ALL CAPS).
e If client is found with that name, double check SSN.
e Search by SSN.
e Search by Alias.
¢ |f match found, open the Demographic form on client and double check DOB,
address, SSN.

S12-
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e Check 3rd Party information to see if client has the same Medi-Cal (BIC, CIN)
number.
e Ifitis unclear which is the first name or the last name, enter the other
position of names in Alias — e.g., Bubble Gum entered into CCl as GUM,
BUBBLE may be entered into Alias as BUBBLE, GUM.

@ Note: When searching use all capital letters, these fields are case sensitive.

¢ You can now search by one or more of the other criteria fields (Last, First,
DOB, Alias Last, First, Sex, Case Number). Select the “Search” button.

Kl Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search o
Client Search Parameters
Case 8 | [H Sort Name | | Search
Last Fist | | oog[// Thu [ 77 [I Defau
Alias Last First Sex x| SSN | 7 Clear

@ Note: If you search by data that is common in the system (such as conducting
a search only by a common first name) you will receive the following warning
screen. This allows you the option to either continue with or cancel the search.

‘?/ The scanning of a large number of Client records has been detected and could lock up the system for a substantial amount of time. ‘Would you like to continue?

Yes | Mo

S13-
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Additional Clien rch F r

e The “Thru” field, in conjunction with the “DOB” field allows you to search for
clients within a particular date range. For example, if the DOB is
approximately 3/10/1964 and you can enter 3/08/1964 in the “DOB” field and
3/12/1964 in the “Thru” field, all clients in the system who have that dates of

birth in that date range will be displayed in the “Client Search Results”
window.

@ Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find
clients born only on that date.

Kl Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search 2
Client Search Parameters
Case #t | [1' Sort Name | Search
Last | | First | DoB | // Thu| 7/ |
Alias Last | | First Sex |- . SSN |_- Clear
_14 -
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RESTORE SYSTEM DEFAULTS

If the layout becomes distorted, or the panes have disappeared, select “Restore Panel

Layout” (under the Layout and Filters button on the Home tab). This will restore the
layout to what it was when you first logged in.

5 y _ﬂz Staff Clear ) o‘} -EE Client Clear '} = Services f&- System eRx not available @ [=ll] D:D
Home N ) = Show Client Panel B = |—E - J—
Staff Refresh Client Add Pharmacy = Break The | Layoutand
Search Staff Panel = Search Client Directory Glass Filters ~
Staff Entity Client Entity Group Notes ePrescribing Status Pharmacies | Break Glass 5l

( Restore Panel Layout
< STAFF ADMIN
Caseload

:}@ Restore Panel Filters
g

Select “Restore Panel Filters” (under the Layout and Filters button on the Home tab) to
bring all the Filters back to their default settings, if desired.

e

Add

' ﬂnstaﬁ-qear ) o‘j -.m Client Clear :" = services ft—System eRx not available @ im""EJ D:D
(id Home L %~ 1 Show Client Panel L+ e
Staff Refresh Client Layout and
Filters =

Pharmacy Break The
Search Staff Panel | Search Client Directory Glass
Staff Entity Client Entity Group Motes ePrescribing Status Pharmacies Break Glass ]
( Restore Panel Layout
<& STAFF ADMIN
Fl
Caseload

,}@ Restore Panel Filters

NOTES

-15-
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CLIENT FACE SHEET

The Client Face Sheet will allow users to view any entered information from the client’s
most recent final approved Safety Alert, Demographic Form, and Diagnosis Form. The
Client Face Sheet displays the Primary Unit, SubUnit and SAI for the client. If the client
information has not been entered on one of these forms, the corresponding information
fields on the Face Sheet will be blank.

e After accessing a client, the Client Face Sheet can be viewed by clicking the “Face
Sheet” pane in the client panel.
< FAKE 2TEST - #0x
Face Sheet - 1
County of San Diego Mental Health Services
FACE SHEET
SAFETY ALERTS

Allergies and Adverse Medication Reactions:

ALLERGIES AND MEDICATION REACTION ON BHAS S

Pre-Intake  Assessm... Primary ...  Primary ... Primary ... Current... Progres...  Authoriz...  Primary ... Services Medical ...  Medicati...

[l
-

¢ The Client’'s Face Sheet cannot be edited from this view. To print click on the drop
down arrow ™ at the top right, and click “Print Face Sheet”.
2 FAKE 2TEST - 2 OX

Face Sheet @
El  Refresh Pane Conten

County of San Diego Mental Health Services I &) Print Face Sheet I

FACE SHEET

SAFETY ALERTS

Allergies and Adverse Medication Reactions:

ALLERGIES AND MEDICATION REACTION OM BHAA L}

216 -
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FILTER SETTINGS

Modifying filter settings to display historical assessments

Each user may personalize the way filters display information in his or her Clinician’s
Homepage. Any time you do not see the desired information, the first step is to check
the filters to assure the correct parameters are selected for your search.

A. On the “Client Panel”, click on the “Assessments” pane. The “Assessments” pane
will open an expanded window.

B. Click the drop down arrow ™ on the “Assessments” bar.

C. The “New Assessment”, “Filters”, and “Refresh Pane Content” window will display.

Click on the check mark ¥ or on the word “Filters”.

=
“ FAKE 2TEST x ?Ox
Assessments @
. ['—-_ [esw Assessment 3
Date Description

Text tode

OC=1

El  Refresh Pane Content

®

Face Sh...  Pre-Intake N Assessm... B Primary ... Primars ..  Primary ...  Current .. Proares..  Authorizo.  Primary .. Services  Medical . Medicati,.,

-17-
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D. The “Filters” window will display. There are three areas where you can make
changes.

E. Date: If a desired assessment is before the date listed, and is not
displaying on the “Assessments” tab; you must adjust the date
manually.

F. From the drop down menu, you may choose A: “Include Final
Approved and non-Final Approved Assessments”, F: “Include Final
Approved Assessments only” or N-Include non-Final Approved
Assessments only”.

G. You may filter by “Assessments Signed By”, “Assessment Type”,
and “Category of Treatment”.

H. You may also place a checkmark by the “Include Voided
Assessments”, “Include Preferred Assessments only”, or the
‘Include the latest Assessment of each type only” choices given.

Assessments Pane Filters ]

—/) Fiters
™ BB
o B O

Refresh Savs and | Close
Chse Panel

Ackions Closa

il Changes to the lollowing lilters will update the display of the Assessments Pane.

General Filters
Lookback Date | 24194200

( F}f« -Include Final Approved and non-Final Approved Assessnents -
|0

Lszesmments Signed by |

Azseszment Tope

Category of Treatmer;

nclude Voided Azzeszments

o

[ rciude Prefermed Assessments only
O
o

nclude the lates: Azzeszment of each lwpe chly

richade Medicalion Corsenl &ssessinenls orly

_18 -
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Filters in Clinician’s Homepage:

Several panes located within the Client Panel contain “Filters”. Below are some
examples:

Assignments Pane Filters: updates the Assignments Pane to display Opened and
Closed Assignments.

Asgignments Pane Filters EX

5—::‘\) Filkers
ol =

Refresh Save and | Close
Close Panel

Actions Close

K Changes to the following filters will update the display of the Assignments Pane.

General Filters

A - Include Open and Cloged Assignments
A - Include Open and Closed Assignments
C - Include Cloged Aszighments Only

0 - Include Open Assignments Only

Thiz filker does nat apply when the Aszignments Pane iz collapsed

Services Pane Filter(s): updates the display of the Services Pane. The date field
filters for services on or after the date entered. Check boxes further filter that data, for
particular service types or services by specified staff, for example.

ﬁq \ Seryice Pang Filters 23

—j Filkers
< b G

Refresh Save and | Close
Close Panel

Ackions Close

* [l Changes to the following filters will update the display of the Services Pane.

Service Filters

Lookhack Date |&/242013

[ Inchude Crisiz Services, Cancellations, and Mo Shows anly

[ Include Services with the Selected Staff anly

Progress Mote Filters

|A - Include Services with and without Progress Motes

|A - Include Services with Final Approved and Pending Progress Motes - |

|A - Include Services with Planned and Unplanned Progrezz Maotes - |

Client Flan Type I |

-19-
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VIEWING CLIENT ASSIGNMENTS
Clinician’s Homepage

Client “Assignments” refer to where the client has received, or is currently receiving,
services. In the “Clinician’s Homepage” you can view the Opening/Closing dates when a
client was assigned to a specific program (Unit/SubUnit/s) and to a specific server.

1. In the “Client Panel” click on the “Assignments” pane.
2. ltdisplays all the assignments attached to the client.

< FAKE TEST
Assignments
Prm | Opened | Closed Unit 1D ‘ Linit Name Sublnit ID | SabUnit Mame | Primary Serv... | Frimary Server Name
[=] 01/01/2015 9900 TRAINING UNT 9901 TRAINING SUBUNIT 300009 STAFF, CLINIZAL
03/05/2015 1000 FAKE UNIT 1001 FAKE SUBJNIT STAFF. FAKE

FauseSheel  Pre-Inlake  Assessoenls | Primary Ciaynosis - ... Primary Subslance Asuse CunenlClenlPlan  Progress Nolss  Authorizaliors  Primary Insuranc

NOTES
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CORE CLIENT INFORMATION

Note: Before entering a new client, always search to ensure that the client is not
@ already in the system. Refer to the “Client Search” tip sheet on the previous
pages.

If you are sure that the client is not already in the system, click on the “Add Client”
button in the “Client Lookup” window.

Client Lockup -

Lookup Panel

=
“ E—““I

A E
Select Add | Show Close
Client | Client Fanel

Actions Close

B Click on the search button to perform a search for client records based on the criteria in the top section.

Client Search 5
Client Search Parameters

Caze # Sort Mame | | Search
ol ] [l (17| e
Blias Last | | First | | sex|- - 55H i

Client Search Results

MName First  Last Case# Sex Eth.. DOB 55N Prim Uni.. Prim U.. Prim SublU.. Prim Sub.. External.. SAIID  SAIN.

There are no items to show.

After you click on “Add Client”, the “Core Client Information Maintenance Panel” window
will display.

Core Client Information Maintenance Panel 2
File Core Client Information
S M X &
= h !
Refresh = Save and Select Close
Close  Client  Panel
Refresh Actions Close

Hl Perform Client search in Client Search Pane. Enter new Client information in Core Client Information Pane.

(2]
=]
T
g Sort Hame | I Case Mumber [0 or blank for Auto Azsign) 1]
g Last Mame IE First I Middle M arne
g DoB 7 |‘?-I Soc Sec # | |‘?-I Ethricity | | sex |:| a
a Addiess | | e Home Phaone I:l a
N [ Rl —
Address County | | Residence County | |
Client Type (@
n
Client Search o
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Just start typing — DO NOT click into the Sort Name field. Doing so could add a space at
the beginning of the field. If this happens, the client will not be found if searched for by
Sort Name. Enter as much client information as you have into the CCI.

In the “Sort Name” field, enter the client’'s name. Do not forget the comma and the
space in between the last and first names. Verify that the spelling and format are
correct, as this is how other staff members will be searching for the client’'s name in the
future.

SortMame [LAST, FIRST SortMame |LAST, FIRST MIDDLE

-0r-

@ Note: If a client’'s name, date of birth, or social security is incorrect, fill out form
BHS-025 and contact Medical Records.

Do not enter a suffix (i.e. Jr., Sr., Il, lll)

Do not enter punctuation, apostrophe (‘) or hyphen (-)

Do not enter spaces (i.e. if the client has 2 last names, run them together)
When names are hyphenated or have another prefix such as Super-Human,
it is important to enter the names into the Alias section to help facilitate future
searches — e.g., Awesome Super-Human should be entered as an alias as
HUMAN, AWESOME and also as SUPER, AWESOME.

e Do not use non-English letters (i.e. A)

e Press the Tab key and the client’'s Sort Name will populate the Last Name,
First and Middle Name Fields

Sart Hame |LAST,FIF|ST MIDDLE | Caze Mumber (0 or blank for Auto Assign) Ijl
Last Name |LAST] |E‘ First |FIRST | Middle Name |MIDDLE
Enter the client’s DOB in the following format: MM/DD/YYYY. DOB 1/ot/zome |2

@ Note: For the remaining optional fields, enter the client’s
information. The information will populate to the Demographics form.

SN =1 el
Click on the “Save and Close” button. L= | X
Refresh § Save and Close
Close Panel
Refresh =1 Close
:;) Case Mumhberis oplionglforth\s Pre-Registered Client.
S Selertho orno Gase Number When asked about assigning a case number to this

Select Gancel to return to the Pane, Cllent, AIW SeleCt “YeS.”
_Yes | Mo || cancel |

The client’s name is now in the system as a new client.
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Enterin hn an ne D lien

When an unidentified client presents, use the following guidelines for entering the client
into CCBH. Note: Once the legal name is known, submit a BHS-025 with supporting
documentation to medical records. The final page in this packet contains that
information.

For all program X E nter:
Sart Hame |DI:|E,J,-’.\NE Mt DD Y | Caze Mumber [0 ar blank for Auto Assign) Ijl
Last Name | DOE |E‘ First | JANE | Middle Mame | MM /DDA

Do /oA1am |2 SocSec B E ity Sex B

-0r-

Sort Hame |DDE,JI:|HN bk DD | Caze Mumber [0 or blank for Auto Azzign) Ijl
LastName |DOE |E‘ First |JOHN | Middie Mame | MM/DDAY

[ulnl:} o090 |® SocSect |:| B E thoricity |:| Sey |:| H

MM/DD/YY = date of client admission/contact. The date will default into the “Middle
Name” field. Delete the numbers in the “Middle Name” field before saving the
record.

If the client’s date of birth is unknown and cannot be estimated, enter 01/01/1901.

Eor the ESU. enter:
Sort Mame |DI:|E,ESLI‘] b 2D D | Caze Mumber [0 or blank for Auto Azzign) Ijl
LastHame |DOE |E‘ First [ES0U1 | Middie Mame |[MM/DDAY

DOE 0104901 |2 SocSect B Ethricity Sew 2

ESU1 = The first John/Jane DOE client of the day.
ESU2 = The second John/Jane DOE client of the day.

MM/DD/YY = date of client admission/contact. The date will default into the “Middle
Name” field. Delete the numbers in the “Middle Name” field before saving the
record.

If the client’s date of birth is unknown and cannot be estimated, enter 01/01/1901.

For John Doe’s, enter “M” as the sex, and for Jane Doe’s, enter “F” as the sex.

223 -
Phase 1 ADE REV 01/2023



Admin Data

Entry

Enterin lients with Identical Nam

This Sort Mame is inuse by anather Client.
Sort kame must he unigue.

.........................................

If the above message appears when entering the Core Client Information (CCI), double
check to ensure that the client is not already in the system. If the existing record is for a
different client, adjust the client’s sort name. This is accomplished by entering the new
client’s date of birth to the end of the client's name. Example:

Sort hame |L,-'3.ST,FIHST MM DD S | Caze Mumnber [0 ar blark For Auto Azzign] I:I
Lazt Mame |L.-'-‘n.ST |E First |FIF|ST | iddle Mame |MM£DDa""r"f

The DOB will default into the “Middle Name” field. Delete the numbers in the “Middle
Name” field, and enter the appropriate middle name/initial. However, do not change the
“‘Sort Name” field. See the example below:

Sort Mame |L,-'1'-,ST, FIRST MM/DD MY | Caze Mumnber [0 or blank for duto Asgzign) Ijl
Last Mame |LAST |E First |FIRST | Middle Name |MM/DDAY |

Sart Hame |L,£'-.ST,FIF|ST bk SO0 | Caze Murmber [0 ar blank. for Auto Aszigh)
Last Mame |m5T |E‘ First |FIHST | tiddle Marme |MIDDLE

Special considerations:
o When available, the client’s middle name should always be entered.
e In the case of identical first and last names, the middle name may be all that
is needed to differentiate among clients. If that is not enough, then the DOB is
added to the end of the sort name field.

e When a date is added to the end of the sort name field, it appears in the
middle name field. Make sure to remove it before moving forward.
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ADDING NEW ASSESSMENTS

From the “Client” tab, click the words “New Assessment”, and click on the assessment
you wish to add.

m Home I Client I View

':" - =)+ o /E £ Prospective Planning Tiers s )
B &) = | @ M = < FEd
Client Broadcast = Mew Progress Mew ew Client Pharmacy Refresh  Close Client
Information+  Alert Maote = Assessment -] Plan~ of Chaice | Client Panel Panel
= Medical Panel Options

Information and Alerts

=i Demographics Form e

Oy
7Y STAFF ADMIN =
Caseload |+ [

Diagnosis Form

Enter the date that the client gave this information to the staff. This is called the
“Effective Date” on the paper form, and it is located in the top left hand corner. Be
mindful when entering this date, as it cannot be changed. After you've entered the

“Effective Date,” select “Save.”

Adding Assessment for FAKE 3CLIENT -

Assessment

Z|Hl & & O3

Refresh Save Prospective  Progress Clase
Planning Tiers Indicators Panel
Refresh | Actions Clinical Clase

H Click Save to confirm selections and add a new Assessment

Aezesement Tope |Demographics Form DEM

| Date [m1/01/2029 | t—
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DEMOGRAPHICS FORM OVERVIEW

e FEorany address;
By entering the “Zip Code” and then pressing the tab key on the keyboard, the
city/state/county will populate.

Citp/State/Zip | || | ;941 | County | |
City/State/Zip L& MESA | [ca | [m94]..] County [San Diego
o For Clients who are Homeless, Incarcerated, or Have No Reported Mailing
Address:
The physical address for a client who is homeless is entered with the word “homeless”,

and a zip code.

@ Note: If you have additional information (i.e.- frequents Balboa Park), type it after
the word “homeless” in the Physical Address field.

Physical Address [HOMELESS |8
City/State/Zip  |S4N DIEGD | |C& | 92103 (.| Courty |San Diego

In the zip code field, enter the zip code of the area where the client sleeps or frequents
(if known).

If you do not know the zip code where the client frequents, enter the zip code of your
program.

For individuals who are incarcerated, the jail's address is entered as the physical
address.

For individuals who have no reporting address, enter the address of the client’s
primary subunit in both the physical and mailing address fields.

e Phone
If the paper demographic form does not include a home phone number, type “NONE”.
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e Religion
If the paper demographic form lists a religion that is not included in the table, use your
judgment to choose the most appropriate selection.

For example: 13 Atheist
12 No Religious Preference
98 Other
08 Other Christian
99 Unknown
Beligion: | |E

e Mother’s First Name
If the client’s “Mother’s First Name” is blank on the paper demographic form, type in
“‘Unknown” instead of “None”.

Mother's First Name [INKNOWH | &

e Alias/Contacts

When adding/editing an Alias or Contact, right click into the box to view your menu
options.

Alias(es)
Last First

There are no items to show,

Bl add Mew

LEGAL INFORMATI
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Help Text

Help Text is available for staff throughout the assessment. Help texts can be accessed
by clicking on the question mark icon. For example, if you click on the “Preferred
Language (Caretaker)” help text icon, the following help text appears:

Prefered Language [Individual] | I E
Preferred Language [Caretaker] | jﬂ
Interpreter Meeded? B Cives (CiMo -

Display Marrative

Cd

Close
Panel

Close

Help

“When a caretaker iz regularly or significantly invalved in the treatment of a client, this field shall be completed. Select the language prefemred by
the caretaker.
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ELECTRONIC SIGNATURE GUIDELINES

Signature Instructions on the Demographic Form.

The Demographic Form allows the form to be signed and final approved in one action.

1. Select “Final Approve,” located at the top of the window.

File Assessment

Pending Demographics Form for

. B [ [ — B 5. = E-q
= 5 L% =

< ® BHuve X & @ x

Refresh Perform Save and Save Final Print Delete Add Prospective Progress Close

Validation Check Close Approve Signature = Planning Tiers Indicatars= | Panel

Refresh Validation Actions Delete | Signatures Clinical Close

2. Enter your CCBH password when prompted.

", Password - STAFF ADMIN

| Paszword |1* e
A

Ok

Signature Instructions on the Diagnosis Form:

Validations

Se... | Validation &

- 1

| Description |

Crit... Pending 5taff Sig...

Crit... Staff Signature R...
Crit,.. Staff Signature R...
Crit... Staff Signature R...

Signatures | Validations

Must be electronically sianed by at least
one Staff Member to be Final Approved.

Sequence 1: Staff Requiring Co-Signature
Seguence 2: Staff Comp/Accept Assess, ..
Sequence 3: Staff Entering Information

229 .

There are three credential restricted
signature lines located in the “Validations”
pane of the Diagnosis Form.

Support staff entering information on
behalf of others, from a hard copy, will
address the signatures as they are listed
on the hard copy.
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Sequence 1:
If the hard copy is signed by a staff that required a co-signature:
1. Sequence 1 (Staff Requiring a Co-Signature) left click and select “Document

Signature on Hard Copy.”

Validations - I

E Seve, .. | Validation & | Description |i

iCritical Pending Staff Signature ... Must be electronically signed by at least one Staff |
| Member to be Final Approved.

Critical Staff Signature Required  Sequence 2: Staff Comp/Ac

Critical  Staff Signature Required  Sequence 3: Staff Entering Electronically Sign

Assign Signatory

Assign Signatory and Sign

Document Signature on Hard Copy

2. Enter the staffs CCBH ID number. Make sure to adjust the date to match the
hard copy. Select “OK.”

chl pocument Staff Signature Un Hard Copy

Signatory | TRAINEE, STAFF (200012 | pate|10/01/2015 | Time[0420PM | | Dk

3. Enter your CCBH password.

f-hf Pacoword - ADMIN GENERIC

PaSS'.-'-.l:lrlj mxxxxx:-xxxx)i I:Ik.
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If the hard copy is not signed by a staff that required a co-signature:
1. Sequence 1 (Staff Requiring a Co-Signature) left click and select “Delete.”

validations 1

Seve... |\.-'aidatinn -~ |Descri|:utinn

Critical Pending Staff Signature ... Must be electronically signed by at least one Staff
Member to be Final Approved.

Staff Signature Required  Seguence 1: Sty

Critical 5taff Signature Required  Seguence 2: 5t
Critical  Staff Signature Required  Sequence 3: St Electroniaally Sign
Assign Signatory

Assign Signatory and Sign

Documen: Signature on Hard Copy

Clear Sigrature

H Delete

Sequence 2:
1. Sequence 2 (Staff Comp/Accept Assessment) left click and select “Document

Signature on Hard Copy.”

Validations
| Sewverity |'u'a|idation - |Des|:ri|:|tion
Criﬁ::—:l Staff Signature Required Seguence 2: Staff Comp/Accept iecaceman +

Critical Staff Signature Reguired Seguence 3: Staff Entering In

Electronically Sign
Assign Signatory
Assign Signatory and Sign

Document Signature on Hard Copy

2. Enter the staffs CCBH ID number. Make sure to adjust the date to match the
hard copy. Select “OK.”

Chi Document Staff Signature On Hard Copy

Sinpistory | STAFF, CLINICAL (600005 | Date[10/01/2015 | Time[0456PM | | ok

3. Enter your CCBH password.

'”!'f Password - ADMIN GENERIC X

Pazzward !’““““““”‘“““’1 0k
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Sequence 3:
1. Sequence 3 (Staff Entering Information) left click and select “Electronically Sign.”

| Validations

Severity |\|'a|idaﬁor1 S Description
| Staff Signature Required Sequence 3: Staff Enterin

=i

uick Add Signature | ¥

~Electronically 5ign

Assign Signatory
Assign Signatory and Sign

Dacument Signature on Hard Copy

Clear Signature

M tions | Signatures Delete

2. Enter your CCBH password.

Ch} Password - ADMIN GENERIC ¥

:ocxxxxx:-xxxx:1 | I I:Ik [

Paszward

3. Select “Final Approve” located at the top of the window.

iAssessment
2 ®» HHileX & & 2 O
<« B ik & V) & bm
Refresh Perform Save and Save Final Print Delete Add Prospective Progress Close
WValidation Check Close Approve Signature = Planning Tiers Indicators = Panel
Refresh Validation A Delete | Signatures Clinical Close
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VIEWING ASSESSMENTS

Saved forms:
e Are “saved” but not final approved.
e Can be edited or deleted by anyone who has access to that client’s forms.
e  Will hold up the work flow as they prevent adding another form in which any fields
are shared.

Lock it down by Final Approving to protect your work!!

How to open a saved assessment:

e Select a client and open the “Client Panel”’. Next, click the “Assessments” pane.
e Alist of assessments will display. The assessment that is not final approved will
not have a check under the Final Approved status (F/A).

e Double click the assessment. The selected assessment will open for data entry
and completion.

-

“ FAKE TEST ECi=
Assessments - 1
|Date = | Deseription jFIA‘LKl v |
07/01/2015 Demagraphics Form =
(070172015 Diagnosis Form

N’

Face sheet Pre-Intake | Assessments | Primary Assig... ) PrimaryDi.. PrimarySubs... CurrentClen... ProgressNotes Authorizations Primary Insur... Services —Medical Cond...  Medications

VIEWING FINAL APPROVED ASSESSMENTS

e Select a client and open the “Client Panel”.

e Next, click the “Assessments” pane.

e Alist of assessments will display. The assessments that are final approved will
have a check under the Final approved status (F/A).

e Double click the assessment. The selected assessment will open for review.

+ FAKE TEST A=l
Assessments - 1
|Date & | Description v |

0723215 Niagrasis Frrm
07(23/2015 Diagrosis Form
|08/21/2015 Diagrosis Form

«TT-E>
q{

Face Sneet  PreIntake | Assessments | Primary Assig... |, Primary Di... Primary Subs...  CurrentClien... Progress Notes Authorizatons  Prinary Insur... Services Medical Cond ..  Medications
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PRINT TO SCREEN

% Note: Before printing a hard copy, always print to screen first to verify whether
printing is truly necessary.

e Click the “Print” button.

| Assessment

2 ® BHilelX & & & 3
Print Delete Add Prospective Progress Close

Refresh Perform Save and  Sawve Final
Validation Check Close Approvd Signature = Planning Tiers Indicators = | Panel
Clinical Close

Refresh Validation Actions

Delete | Signatures

Click on the down arrow to the right of the “Printer” field, click “Print Preview”,
and click the “Print” button.

Print Assessment

Refresh  Print Close
Panel

Actions Close

Hl Select options related to the printing of the Client's Assessment

Printer
F"rinter| Drefault Printer { v| ,

Generating It will take a few moments to process the command. Wait
until the following message disappears.
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A copy displays on the screen. Pay attention to the total number of pages before
deciding to print a physical copy.

[
| Mamz: LET, FIRET MICCDLE Cased: Pcoge: 1 eof2 1—____
| Tuwpe: Drate:
Brleted o DA i3 m T e
.

You will find icons across the top of the print screen which will allow navigation through
the copy.

SEm TER Kd DD I O®

Prints a physical copy.

(=] Emails a copy. DO NOT use this feature, as it is a breach in confidentiality.
111 Displays the default size of the copy.

Shrinks the copy down to 25% of the default size.

& Zooms in by 50% each time the icon is clicked.

S Zooms out by 25% each time the icon is clicked.

K Navigates directly to the first page.
] Navigates back one page.

P Navigates forward one page.

Do Navigates directly to the last page.

7 Displays keyboard commands for navigating through the copy.

¥ Displays the details of the software product.

® Closes out of "Print to Screen” and returns to the original view.
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To get to the Client Assignment window:

Click on the “File Tab”
Click “Menu”
Click “Client Assignments”

NS

me Client View
Open
—

Menu

Recently Opened Views

Client Profile

F
g Security [ L—F
Al
' Scheduler

About CCBH —

P B RN I R Y
‘ 2 'Application Menu

Click “Client Assignments Maintenance”

a2 00

ining Tiers

Entry

R 7 e

B o =
_— s &
Pharmacy Refresh  Close Client
of Choice = Client Panel Panel
Medical Panel Options

Client Assignments

@ u I I Client Assignments Maintenance @l

Client Financial Information

Client Reviews

: 3 Client Treatment Sessions Maintenance

3 Client Categories Maintenance

There are two ways to access the Client Assignment Window from the external view.

1. Click on the “Home Tab”, then “Menu”, click on “Client Assignments”, then select
“Client Assignments Maintenance.”

2. From the short cut menu on the left, if you have created one, click once on the

“Client Assignments icon.”

c
()

3 S Clear Global Client - =
= &

8 I | ; 2
Client Client Batch Menu
Search Profile~ Maonitor = &

Global Client Batching

" New Client

3 Client Assignments | < ——

CCBH Central Training (Staff: STAFF ADMIN})

®

Application Menu

Client Profile

' Scheduler

Client Assignments

O)

Client Financial Information
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The “Client Assignments Maintenance” window will display.
¢ Inthe blue field, enter the Client’s case number or the Client’s sort name (Last,
First) in the “Client” and press the “Tab” key.
e Click the “Add” button to begin the opening of the assignment process.

2 Client Assignments Maintenance (Administrative Access) o ] 4|
Client: |TEST. FAKE [ [dmitted

sp: [STAFF. CLINICAL

Treatment 5 ession: I“ SI — I I

L it | 1D | Sublnit | 1D | F'| Server | Opened... | Clozed | Status | -

' Dpen dAssignments © Clozed Assignments Al Azsignments |

Treat Sess Multi-Close Add Edit Delete FErint Shaow Clear Find | Esit |

Note: If you get an error message that reads, “Assignments may not be entered for
pre-registered clients” this indicates that on the demographic form, the “Admit” radio
button was not checked. This requires updating the demographic form and selecting
the “Admit” radio button.

e From the “Assignment Form Entry” window, enter the effective date of the Client
Assignment opening and the CCBH ID number of the staff completing the form.

e From the Form Type field, click on the arrow and from the drop down menu,
select, “A-Admit” and click, “Ok”.

Assignment Form Entry

Effective Date | 01012023

Form Completed By | STAFF CLIMICAL E
Date Form Entered | 01./20/2023 '

Farm Entered By

= .‘;'.U.Illil.
- Cloze
- Register [n]3 Clear Cancel
- pdate

i B L |
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¢ A new Client Assignment window will appear:

Client Assignments Maintenance

Client |3CLIEMT, FAKE Clazed - Adm
SA|
Treatment Sezsion |/ / —

Aszsignments | Server Higtory | FRoom/Bed History | Room/Bed Histom [2] I Home Provider History | Abzence Histor I Inpatient Claims I Far 4 | *
bain | RTF/Restorative | Refeming Provider I California Admizsions I "W State Reparting I T State Reparting |

Treat. Seszion |/ / E —
Date Opened |01/01/2023 Type |Admitted
Unit | TRAIMIMG UMIT E 9300 [ Primary Urit
Sublnit | TRAIMIMNG SUBUMIT &a)[9301
:l [ Transition of Care
Treatment Team E
Current Server |STAFF CLINICAL E Start Date | /7 Tirme
dasignment Cat || 5 Foam E
Admizzion Type E
Tran From Unit El %
Tran From Sunt =
Date Clozed |/ / Reasz g Time
Tranzfer ta Linit E
Tranzfer to Sublnit g

Clear FReturn E wit

Treatment Session: Leave this field blank.

Date Opened: This date pre-populates from the previous window.

Unit: Enter your program Unit in this field; hit the “Tab” key.

Sub Unit: Enter your programs SubUnit number in this field; hit the “Tab key.
Treatment Team: Leave this field blank.

Current Server: Enter the Server's CCBH ID number.

Note: The date from the “Date opened” field will auto populate from the previous
window. If it's not correct, select cancel and return to previous step.

e The final step is to click the “Save” button.

e After you have clicked “Save”, you are taken back to the “Client Assignment
Maintenance” window.

e The Assignment Status for this client is now “Admitted.”
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e The highlighted entry below represents the completed assignment opening
effective 01/01/2023.

Client Assignments Maintenance (Full Access)

Client | 3CLIENT. F&KE g Adrmitted
S& |STAFF CLINICAL

Treatment Session | g =
Uit [ Sublrit D F Server Opened... Clazed Status A
TRAIMIMNG UMIT 9300 TRAIMIMNG SUBLIMIT 930 ¥ STAFF CLIMICAL 01/01,/2023 Adm

(® Open Assignments () Closed Assignments (O &l Assignments

Treat Sess Multi-Close fidd Edit Delete Frint Shiow Clear Find E it

How to Update a Server

e Open the “Client Assignments Maintenance” window.

¢ Inthe “Client” field, enter the Client’'s case number or the Client’'s name (Last,
First) and press the “Tab” key on your keyboard.

e Select the assignment you want to update by clicking on the Unit name until it’s
highlighted.

e Click the “Edit” Button.

Client Assignments Maintenance (Full Access)

Client | 3CLIENT, FAKE g Adrmitted
SAl | STAFF CLINICAL

Treatment Session | g —
Unit [ Subldmit [[n] F Server Opened... Cloged Statug ~
TRAIMING UNIT 9900 TRAIMIMNG SUBLIMIT 9301 Y STAFF CLIMICAL 0140142023 Adm

(®) Open Assignments () Closed Assignments () All Assignments

Treat Sess || MultiClose Add Delete Frint S Clear e Exit
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The “Assignment Form Entry” window will display.
Enter the effective date of the Client Assignment update and the CCBH ID

number of the staff completing the form.
In the “Form Type” field, click on the drop down arrow, select, “U-Update” and

click, “OK”.
Assignment Form Entry =

Effective Date | 01/01/2023
Forrn Completed By | PRACTICUM COLLEAGLUE E
Date I oim Entered | 01717/ 2023

Form Entered By |STAFF ADRIM

Form Tepe

Ok Clear Cancel

A new Client Assignment window will appear. The following fields will auto
populate from the previous window: Date Opened, Unit & Sub-Unit, and Current
Server.

Delete the Current Server and Enter the New Server's CCBH ID number and
press the “Tab” key (the start date to the right will update).

The last step is to click, “Save.”

Client Assignments Maintenance (Full Access)

Client |3CLIENT, FAKE Adritted
Sa&l | STAFF CLINICAL
Treatment Session |01/01/2023 — 1-54N DIEGO COUNTY MEMTAL HEALTH

Assighments | Server History I Foom/Bed History I Foom Bed History [2] I Home Pravider Histary I Absence History I Inpatient Claims | Farr|

Main | RTF/Restorative I Fieterring Provider I Califoria Admizsions I ‘Wi, State Reporting I T State Reparting |

[] Transition af Care

Treal Sesson |01/01/2023 O] —| / 1- 54N DIEGD COUNTY MENTAL HEALTH
Date Opened | 01/01/2023 Type |Admitted
Urit | TRAINING UNIT /300 v
Sublnit | TRAINING SUBUNIT [ EE [0t i U

Treatment Team ||

I Current Server | STAFF CLINICAL

Start Date | 01/001/2023 Iime
Room g

Azsignment Cat

] [ [

Admigsion Type

Tran From Unit
[SU

Tran From Sunt

Date Closed | /¢ Feas g Tirme:
Transfer ta Linit g
Transfer to SubUnit E
—
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o After you have clicked “Save”, you are taken back to “Client Assignment
Maintenance” window.
[/ dlient Assignments Maintenance (Administrative Access) =10 x|
Client:; [TEST. FAKE af |Closed - &dm
sal. | [
Treatment Session: I s BI — I I
Lnit | [u] I Sublnit | [u] | F'| Server | Opened... | Clozed I Status | :I
TRAINING UMIT 3900 TRAIMING SUBLINIT 3501 TRAINEE, STAFF 08/18/2015 A

]

|

" Open Assignments © Closed Assighments ¢ &l Assignments |

TreatSess | MultiClose | add |  Edt | Delete | Bt | shew | o | B | i |

e The highlighted entry above represents the completed Server update and reflects
the new Server: TRAINEE, STAFF.

How to Close a Client Assignment

e From “Client Assignments Maintenance” window; enter the Client’s case number
or the Client’'s name (Last, First) and press the “Tab” key.

e From the display window, select the assignment you want to close by clicking on
the Unit name until it’s highlighted.

¢ Click the “Edit” button to begin the opening of the assignment process.

T2 Client Assignments Maintenance (Administrative Access) 1= =]
Client: |TEST, FAKE = [Closed - Adm
s4l: | |
Treatment Session: I L SI — I I
Lt | 1D | SublInit | 1D | F'| Server | Opened... | Cloged | Status | ;l
TRAINING UNIT 2500 TRAINING SUBLINIT 2901 TRAINEE, STAFF 08/18/2015] A

I

=l

" OpenAssignments © Clozed Assignments 1% &l &ssignments |

Treat Sess Multi-Cloze Add I Edit | I Delete FErint Show Clear Eind | Exit |
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¢ From the “Assignment Form Entry” window, enter the effective date of the Client
Assignment closing and the CCBH ID number of the staff completing the form.

e From the Form Type field, click on the arrow and select, “C-Close” and click,
“OK!!‘

Assignment Form Entry

Effective Date | 01/17/2023
Form Completed By | STAFF ADMIM E
Date Form Entered |01 417/2023

Formn Entered By | STAFF ADMIM

Farrmn Type | 11 - Update -
B Update |

Clear Cancel

¢ A new Client Assignment window will appear. The following fields will auto
populate from the previous window: Date Opened Unit & Sub-Unit, Current
Server and Date Closed.

e Closing Reason: Click on the magnifying glass to show the closing reasons

Client Assignments Maintenance (Full Access)

Client | 3CLIENT. FAKE Admitted
Sal |STAFF CLINICAL
Treatment Session |01/01/2023 — M 1- 54N DIEGO COUNTY MENTAL HEALTH

Assigriments | Server Histary I Fioom/Bed Histary | Fioom/Bed History (2] I Home Provider Histony | Abzence History | Inpatient Claims | Far| | "

b ain | R TF/Restorative | Referring Provider | Califarnia Admissions | Wi State Reporting | T State Reporting |

Treat. Session |01/01/2023 g — 1-5SAN DIEGO COUMTY MENTAL HEALTH
Date Opened | 01/01/2023 Type |Admitted
Unit | TRAINING UNIT E 3300 v

[ Lack Primary Uit

SubUnit | TRAINING SUBUMNIT 4990
.ﬂ [[] Trarsition of Care

Treatment Team

Current Server | STAFF CLINICAL Start Date |07/01/2023 Time

Foom E

Aszzignment Cat

Admizzion Type

Tran Fram Unit
B N
Tran From Sunt
=0

Date Cloged |01/17/2023 Fieas ||

Time

[ Tranzfer Tranzfer ta Unit
Transfer to Sublinit

&
&

Treat Sess Print Save Beturn Exit
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¢ The “Assignment Close Dispositions Lookup” window will display.
e Select the applicable code and press “OK”.

Assignment Close Dispositions Lookup

... Drescription. . ~
AF Another ypeHealhCarefacily
B Board & Care
aG Cancer Center/Childrens Hozp
C Criziz Residence _
AL Critical Access Hosp [CAH) =
Al Cuztodial w/plan [PT readmit
] Death/E #pired
A Dizaster Alternative Care Site
b Do Mat Usefduto Close W
(@) Active () Indsctive Ca

Ok Find Exit

e The last step is to click, “Save.”

Client Assignments Maintenance (Full Access)

Client |3CLIEMT, FAKE Admitted
Sal | STAFF CLIMICAL
Treatment Session | 01/01/2023 — e 1-5AM DIEGOD COUNTY MENTAL HEALTH

Azzigriments | Server Histary | Fioom/Bed History | Fioom/Bed Histany [2] I Hame Provider Histary I Abzence Histary | Inpatient Claims I Farr| * [ *
Main | RTF/Restarative I Refering Provider I Califarnia Admissions I Wi State Reporting | T State Reporting |

Treat Session | 01/01/2023 0] — | 4/ 1-54N DIEGD COUNTY MENTAL HEALTH
Date Opened | 01/01/2023 Type | Admitted
Urit | TRAINING LINIT @230 v
Sublinit | TRAINING SUBUNIT 2 3301 WL Pimery Ui

[ Transition of Care

Treatment Team ﬂ
Current Server | STAFF CLINICAL E Start Diate | 07/01/2023 Tirne:
Aszzighment Cat E Foam E
Admizsion Type E
Tran From Unit
(I
Tran From Sunt
Date Cloged |01/17/2023 Reas |Home/Sheler/Self @ H Time
Tranzfer to Unit E
Tranzfer to SubUnit E
Treat Sess Print Betumn Exit

o After you have clicked “Save”, you are taken back to “Client Assignment
Maintenance” window.
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e The Assignment Status for this client is now: “Closed-Adm.”

e The highlighted entry below represents the completed assignment closing
effective 07/17/2023.

e Ensure to select the radio button for “Closed Assignments” or “All
Assignments” to view.

Client Assignments Maintenance (Full Access)

Client |3CLIEMT. FAKE E Cloged - Adm
Sl
Treatment Session | /7 E —
Unit D SubUnit D F Server Cloged Status ~
TRAIMIMG UMNIT 9300 TRAIMING SUBUMIT 9301 STAFF CLINICAL

() Open Assignmentl (D) Clozed Assignments () All Assighments

Treat Sess tulti-Cloge Add Edit Delete Print Show Clear Find Exit

Adding MD or RN Unit/Sub-Unit (If Applicable):
NOTE: Billing cannot be entered for an MD or RN subunit, as is not setup for billing

purposes. The purpose of adding the MD and RN subunit, is so they are able to see the
client on their caseload in their Clinician’s and Doctor’s Homepage.

NOTES
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CLIENT SEARCH
External View

Client search:

¢ Click on the magnifying glass icon.

Client Assignments Maintenance (F
Client | —

e The “Clients Lookup” window will display.
L Clients Lookup =

Sort Mame... CazeMumb.. S5 E DOe... SS5H Prirmary ... Primary Sdnt ExtCaze.. 54

M1 5300 9301
OBEAVER, BELOVED M1 1]
OCHIPS, AFFLE M1 1]
ODOG, PawS Mo 9300 9301
OF D, FANCY Mo 5300 9301 =
OHIPFO, ANIMAL M1 9300 9301
OLLAMA, LINT Mo 1]
OPUPFY, SNUGGLE M1
OTURTLE. TIGER M1

a
0 L
< n >

Aliaz Lookup Filters () Open Clients () Closed Clients (@) Al Ok Eind Eit

MULTIPLE WAYS TO SEARCH

Searching by Sort Name:

Before you begin your search, select the “All” radio button.

To begin the search function, place your cursor in one of the boxes under the
“Sort Name” column.

. You will see a dotted outline that appears around the box that you selected.

4. Start typing the last name of the client that you are searching for in capital letters.
The “Sort Name” box appears.

Ok
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5. Type LASTNAME comma space FIRSTNAME.
6. Click “OK”.
7. After you locate your client click “OK” once more.

Searching by Case Number

1.
2.

5.
6.

Select the “All” radio button.
To begin the search function, place your cursor in one of the boxes under the
“Case Number” column.

3. You will see a dotted outline that appears around the box that you selected.
4.

Start typing the “Case Number” of the client you are searching for. The “Case
Number” box appears.

Find: Case Number.. =

| Ok

Click “OK”.
After you locate your client click “OK” once more.

Searching by Date Of Birth

1.

Select the “All” radio button.

2. To begin the search function, place your cursor in one of the boxes under the

“‘DOB” column.
You will see a dotted outline that appears around the box that you selected.
Start typing the “DOB” of the client you are searching for. The “DOB” box

appears.
Find: DOB... =

O Ok,

Click “OK.”
After you locate your client click “OK” once more.
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Searching by Alias

1. On the “Clients Lookup” window, click on the “Alias Lookup” button.

Clients Lookup

Sort Mame... Caze Mumb.. 5 E DOe... SSH Frimary ... Primarg SUnt - Ext Caze...  SA A
39 9300 3901
TACURA, L M9 9300 3501
14DE, 1FALL M1 0
1ADE, 15KA Fo2 9300 3501
T4DVENTURE, CALIFORMIA M5 9300 3501 =
1ALL, vaYFOR M5 0
TALOMNGS, SING M5 9300 3501
TAMDFRIEMDS, SNOOPY M5 9300 3501
TaMIMAL, STUFFED M5 9300 3501 ™
< 11} >
Filters (O Open Clients () Closed Clierts — (8) All oK Find Exit

2. The “Client Aliases Lookup” window will appear.

Client Aliases Lookup

Lazt name... First name... M Client Mame Client 1D A
DEREY  CRENTUCEY WwiNTER, HOLIDAY 389
DEREY EEMTUCEY LENOWO, LAFTOF Ea3
DEREY KEMTUCEY WValD, LAPTOP Eog W
ak Find E xit

Searching by Last Name:

1. To begin the search function, place your cursor in one of the boxes under the last
name column.

2. You will see a dotted outline that appears around the box that you selected.

3. Either click “Find”, or just start typing the last name of the client that you are
searching for in capital letters. The “Last Name” box appears.

Click “OK”.
After you locate your client click “OK” once more.

ok
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Searching by First Name:

1.

2,
3.

4,
5.

To begin the search function, place your cursor in one of the boxes under the
“First Name” column.

You will see a dotted outline that appears around the box that you selected.

Start typing the last name of the client that you are searching for in capital letters.
The “Last Name” box appears.

Find: First name...
| Ok

Click “OK”.
After you locate your client click “OK” once more.

If the client is not located after a thorough search, users may add that client to the MH
MIS system (see the “Core Client Information” tip sheet).

Search reminders and things to keep in mind:

Always select the “All” radio button when searching.

Use CAPS when searching by name.

Remember if you are searching by client’s name, enter it in the following way:
LASTNAME comma space FIRSTNAME. (e.g. CAR, BLUE). Except Alias, which
you search by LASTNAME and FIRSTNAME separately.

You must complete a thorough search before adding a new client. Search by
Client Name, Social Security Number (SSN), Case Number, Date of Birth (DOB)
and ALIAS.
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DISPLAY AUDIT EVENTS

To see when an assessment was added, edited, final approved, viewed, or printed,
utilize Display Audit Events. Display Audit Events will display who touched the
assessment, when, and what action was completed.

1. Right click on the assessment details you wish to view. Select “Display Audit

Events.”
2 CREATIVE CLIENT .
Assessments - 1
Date & |De5cnption |F,FA| LK | v | |

12/01/2017

Demographics Form ]

Diagnosis Form

12/01/2017 Safety Alerts Assessment Maintenance =
12/05/2017 Client Plan Confirmatior Show Assessment =
12/15/2017 BHA Children X | void -

g4 Print Assessment

H Display Audit Events

Face Sheet  Pre-Intske  Assessments | Assignments i.'l Diagno... E.IJ Substa... ClientPlans  Progress ... Authorizat...

Medications  Client Atta...

2. Each column in the window that appears can be sorted by clicking on the column
header. The window will display a line for each separate action a staff takes (add,
edit, sign, final approve, display, and print).

Insurance ... Services Medical Co...

Assessment

0

Display Close

Details Panel

Actions Close

Audit Events

Event Action |Date ~ |Time Staff ID | Staff Net ID Windows 1D
Azzessment Add 1/13/2023  0%28 AM 910004 STAFF ADMIMN COSDCACTXAD
Aszzessment Edit 1/13/2023  0%28 AM 910004 STAFF ADMIMN COSDCACTXAD
Aszessment Edit 1/13/2023  0%32 AM 910004 STAFF ADMIN COSDCACTXAD
Aszzessment Edit 1/13/2023 0%36 AM 910004 STAFF ADMIMN COSDCACTXAD
HAzsessment 09:37 AM 970004 COSDCACTXAD

Electronic Sig... 1/13/2023

3. Select “Close Panel” to return to the
Assessments Pane.
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STAFF MAINTENANCE LOOKUP
How to Lookup a Staff for Contact Information

e From the CLINICIAN’'S HOMEPAGE, click the “File Tab”, click “Menu”, click
“System Tools”, and click “Staff Maintenance”.

CLINICIAN'S HOMEF

ichy,
e @

:_'E Services )'L— System eRx not a

Recently Opened Views
& - =
— l’"A'I ."II:.-...-.;. .l.—.—;u-q..nn-.-uni‘.— BAoimt oo cn
pplication Menu
Menu sroup Motes ePrescribing 5ta
Client Profile 4
Security | A=F
1l
" Scheduler 4
ﬂ About CCEH —_
" Client Assignments -

L There are no

Client Financial Information

Client Beviews d
Client Services - |
ATE d
" System Tools @ 2 _| Pay Sowurces Listing
Beimbursement g _| Service Codes Listi
— 4
| _,.3' 5taff Maintenance
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e From the EXTERNAL VIEW, click on the “Home Tab”, then “Menu”, from the drop down
menu select “System Tools”, then “Staff Maintenance”.

CCBH Central Training (Staff: STAFF ADMIN)

[ =
] O
= GqClear Global Client i GI == @
:k ¥ F

Client Client Batch

| Menu
Search Profile = | Monitor = =
Global Client Batching Application Menu
ol " Client Profile

EZ ' Scheduler
b

" Client Assignments

" Client Einancial Information
" Client Reviews

" Client Services

" ATP

¥

' System Tools @ » |m Pay Sources Listing

" Reimbursement 4 E ﬂ-[ Service Codes Listin

| 3' Staff Maintenance

“Staff Maintenance” Menu:

When the “Staff Maintenance” Menu launches, your staff ID and name will be
highlighted in blue as a default. Your current contact information on file will be listed
under the “Main”.

Staff Maintenance (Administrative Access)

o Sort Mame Center Phone ~ (®) Active (CJinactive (&l () Deleted
500013 STAFF, TFC
800023 STAFF, PM Login
210001 RM1 DHP () Permitted () Mot Permitted [OFA]
910003 STAFF CLINICAL Activity recorded in the Clinical Products
910004 STAFF ADMIN = ) ves (CIMa ) Al
910005 DMLY, WIEW
~
Options Currently Yiewing Information for Main
I Main I

3 ministrator 910004 e

i Options STAFF ADMIN I

i Unit/SubUnit A

;uUnitfSublinit Access STAFF = Staff Name History

- Languages

- Meaningful Use

i..DR Prescription Information ADMIN

& save O3, Find x| Exit
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e Press the “Find” button at the bottom of the window. /

»

e The “Search: Sort Name” box will launch. Q Eind (Bt

NOTE: You may search by “ID” or “Sort Name” by clicking under the desired column
before pressing “Find”. A red dotted box will display under the field you

are searching.

1D | Sort Mame I Center Phone | A| 10 I'SortName I Center Phone
1 CLIMNICIAN, AWESOME (619} 555-5555 1 CLIMICIAN, AWESOME (618 555-5555
2 CLINICIAN, AMAZING (619) 555-5555 2 [CLIMICIAM, AMAZING (E1%) 555-5535
3 CLINICIAN, FANTASTIC (619) 555-5555 3 |CLIMICIAM, FANTASTIC |(B1%) 555-5555
4 CLINICIAN, SUPERB (619) 555-5555 4 |CLIMICIAN, SUPERB (619) 555-5555
5 (CLINICIAN, TEST {E19) 555-5555 _I CCLIMICIAN, TEST {618).565-5565
6 CLINICIAMN, MAGICAL (619) 555-5555 | CLINICIAN, MAGICAL | (619) 55-6555
7 CLIMICIAN, EXTRADRDIMAIRE (619) 555-5555 CLIMICIAN, EXTRADRDIMNAIRE |(B189) 555-5555
8 | CLINICIAN, INCREDIBLE (619) 555-5555 INICIAN, INCREDIBLE |(B189) 555-5555
9 CLINICIAN, WONDERFLIL (619) 555-5555 9 | CLINICIAN, WOMNDERFUL |(B1%) 555-5555
10 CLINICIAN, MAGMNIFICENT (619) 555-5555 Ll 10| CLINICIAN, MAGNIFICENT (619) 555-9555

Search Window:

Search: Sort Name

X

|ELINIE.L‘«L, STAFHA

e Type in the desired

name of the staff you

wish to find.

NOTE: The format must be last name, comma, then SPACE, and first name. For
example, “CLINICAL, STAFF” would be the proper format.
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Options

l""Main I
--Administrator

- Options

- Unit/SubUnit Access
--Languages

- Meaningful Use

- DR Prescripticn Information

Currently Viewing Information for Main
0003
STAFF CLINICAL

STAFF

CLIMICAL

519-123-1234
CLINICAL@EMAIL.COM

The contact information of the staff for which you have entered will display under

“Main”.

The “Internal Phone” number as well as the “Email Address” will be listed when it

is available.

NOTES
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Client Categories Maintenance

Entering Client Categories Maintenance:

Once the program has confirmed that a client belongs in one of the client categories in
CCBH, programs must make the appropriate designation. There is a brief glossary

attached about each category.

This is done through the “Client Categories Maintenance” screen.

Once the client’'s name has been selected from the CHP (and the Client Panel is

open), follow these steps:

1. From the Clinician’s Homepage (CHP), go to the “File Tab”, click on “Menu”,
then click “ATP”, then select “Client Categories Maintenance”.

e

th

o NOME

Recently Opened Views
Open L

2 4 CEoFE Blnaintananca
Menu pplication Menu

Client Profile

Security > |
{

" Scheduler
About CCEH —_

=Jfs B3

Client Assignments

Client Financial Information

Client Reviews

Client Services

CLINICIAN'S HOMEPAGE (1

:_'[: Services _h- System eRx not available
= pn

sroup Motes ePrescribing Status

There are no items tc

‘ ' ATP

2 | ’_T Client Categories Maintenance
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2. The “Client Categories Maintenance” window will launch, with the name of client
you selected on your CHP pre-populated in the “Client” field. (If you did not
select a client prior to this step, simply enter the client number in this field and
select “Tab” to populate the client’'s name).

[ Client Categories Maintenance (Full Access) = =
Client | 3CLIENT, FAKE < & Clased - Adm B
SAl
..".Eategoly . Description Effective Date  End Date Status h
Open =
W
® active () lnactive (A
Cabeqory 7.7
Effective Date | / /
EndDate | / ¢
Pravider Mame Last, First
Pravider MPI
Provider Licenze Type [

Pravider Humber

Pravider LIPIN

[ Save K Delete N Clear x| Exit

3. Click on the “Magnifying Glass”. This will open the “Client Categories Lookup”
window. Select the appropriate option for your client.

e Client Categories Maintenance (Full Access) = =
Client | 2CLIEMT ., FAKE [ Closed - Adm HE
Sl
Deszcription Effective Date End Date Status -~
| Open =
b

(®) Active () lnactive A /

J..
¥

Category
Effective Date | # #
EndDate | / #

[ = EPY Amr B~ | =~k Cirnd
~55-
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4. Your selection will now populate in the “Category” field. Next click on the

5.

“Effective Date” calendar icon to add the date it was determined the client was
eligible. Once the date has been entered, click “Save” to save your selection.

(@ active () lnactive (Al

Categony |Katie A Subclazs E 12

Effective Date | 01/01/2023
EndDate |
Provider Mame Last, First
Prowider NP 0
Frovider Licenze Type E
Provider Mumber

Provider UPIN

n Save X Delete % Clear ﬂ Exit

Your saved selection will now appear in the middle container. You can then click
on the “Exit” button at the bottom of the screen to close the window.

Chent Categories Maintenance (Full Access)

Client | 3CLIEMT, FAKE 1| Closed - &dm B
Shl
Category D escription Effective Date  End Date Status ~
12 Fatie & Subclass 01/07/2023 Open =

(® Active () Inactive Al

Category | Katie A Subclazs g 12
Effective Date | 07./01/2023
End Date |

Provider Mame Last, First
Provider MPI 0

Prowider Licensze Tyupe

5

Provider Mumber

Provider UFIM

n Save 7% Delete % Clear il Exit
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6. When the program has confirmed that the client is no longer eligible, the program
must return to the “Client Categories Maintenance” screen to enter an end date. It
is the same steps as 1-2, except the program is entering information into the
“‘End Date” instead of the “Start Date” field. Once the end date is entered, make
sure to click “Save”. This saves the updated information in the middle container.

e Client Categories Maintenance (Full Access) = =
Client |3CLIEMT. FAKE 1] Clozed - Adm R
S Ve
Categony Dezcription Effective Date End Date x Status ~

nz iKatie & Subclass 01 /01/2023 01/13/2023 Cloged

(®) Active () Inactive aal
Category |K.atie & Subclazs :-J 12

Effective Date |01/01/2023 [EH|
| EndDate |m/15/2023 IE|

Provider Mame Last, First

FProvider MNP 0
Prowider Licenze Type :.J
Provider Mumber
Provider UPIM

[ save 7 Delete S Clear | x| Exit

7. Then, click on the “Exit” button at the bottom of the screen to close the window.
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Client Category Maintenance Glossary

AB109

A funding source for clients that are low risk offenders released from State custody to
the County of San Diego for supervision and services. Alcohol, Drug & Mental Health
services at various programs are provided to those that qualify for them. The goal is to
provide supportive and rehabilitative services to these individuals to help them meet
their needs and stay out of the justice system.

“AB109 Funded” are those programs that have a contract with the County to provide
services to this population, and the “AB109 Non-Funded” are programs that an AB109
designated client may go to if the funded programs are full and impacted, but the
program is not receiving contract funding for the services. The “Funded” programs are:
CRF HEARTLAND CENTER, CRF MARIA SARDINAS WELLNESS & RECOVERY,
EXODUS CENTRAL, and TELECARE PROPS.

Assertive Community Treatment (ACT)

ACT Services are provided in a multi-disciplinary team-based model of service that uses
a comprehensive team approach and provides treatment 24 hours a day, 7 days a
week, 365-days a year. The services are targeted for homeless persons with a severe
mental illness who may have a co-occurring disorder, are unconnected to outpatient
services, may be referred by the justice system, have multiple major areas of
impairment, have more than one long term care episode, and multiple ER and acute
care hospitalizations and justice related episodes.

The ACT program provides integrated mental health and medication services,
rehabilitation and recovery services, intensive case management and have a staff-to-
client ratio of approximately 1:10. Clients are typically provided services in person at a
minimum of four (4) times per week to meet with the client’s clinical needs and meet
ACT fidelity rating. Services may be provided on a much more frequent basis,
depending on client need.

ACT Strength-Based Case Management (SBCM)

Strengths-Based Case Management services are delivered through BHS contracted
service. Programs assist clients with severe mental illness who may have a co-occurring
disorder to access needed mental health, medical, educational, social, prevocational,
vocational, housing supports and rehabilitative or other community services. The
service activities may include, but are not limited to case management, care
coordination, referral and linkage to needed services; monitoring services delivery to
ensure beneficiary access to services and the services delivery system, monitoring of
the client’s progress, and plan development
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AOT Court Ordered

Assisted Outpatient Treatment, also known as Laura’s Law, is a process by which the
court, after a thorough investigation, orders an individual into an appropriate level of
treatment. Individuals who are ordered into treatment are required to meet 9 criteria
under Laura’s Law with the primary deciding clinical factor being client is “substantially
deteriorating.” As part of the petition process, the licensed mental health clinician must
prove to the court via an AOT evaluation that this level of treatment is the least
restrictive level of treatment and, if not ordered, may result in the decompensation of the
individual. The treatment offered in this category is the same level of treatment as an
Assertive Community Treatment model.

AOT Voluntary

Similar to AOT Court Ordered, the individual is required to meet nine criteria under
Laura’s law with the primary deciding clinical factor being client is “substantially
deteriorating.” In this category, however, the client has not been court ordered into
treatment. Though the client has met the definition for Laura’s Law and a licensed
mental health clinician has conducted an AOT evaluation, the client has willingly agreed
to participate in the AOT program and avoid the court process. The treatment offered in
this category is the same level of treatment, an Assertive Community Treatment model,
offered to individuals in the AOT Court Ordered category.

Augmented Services Programs (ASP)

Strive to enhance and improve client functioning through augmentation of basic Board
and Care (B & C) services to specific individuals living in specific B & C facilities with
which the County has an ASP contract. Emphasis is on developing client strengths,
symptom management, and client self-sufficiency. Priority for ASP services is given to
those people in most need of additional services. Any BHS funded case management
services program may refer to ASPs.

Emergency/Transitional Shelter Bed

The goal of ETSB is to provide short term housing assistance to individuals connected
to the respective clinic while stable income is sought. Emphasis is on securing stable
income, symptom management, and client self-sufficiency. Priority for ETSB services is
given to those people with a pending SSI claim.

BHS Regional Clinics (North Central, East County, North Inland, and North Coastal) are
the designated locations for referrals to the Emergency & Transitional Shelter Bed
(ETSB), through the respective clinic Homeless Outreach Worker (HOW).

Katie A.
A shorthand way of referring to the settlement agreement for a class action lawsuit
brought against the County of Los Angeles and the State of California. The result is that
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specific collaboration between County Behavioral Health Systems and Children’s
Welfare Services is mandated so that certain children in both systems of care are
guaranteed to receive intensive services to address their needs of safety, permanency
and well-being. It is for Children’s programs only. In San Diego County, we refer to Katie
A. as Pathways to Well-Being or the acronym PWB, so you may hear this language in
your program. The class action lawsuit settlement defined members of the class and
members of the subclass. These are legal terms that spell out what criteria need to be
met in order to receive the specialty mental health services that the settlement defines.

A clinician in your program will give you a form that says if the client meets criteria for
Katie A Class or Subclass. This is the information you will put into Client Categories
Maintenance. There have been several trainings on PWB, so if you are unfamiliar with
this and the services provided (and you work in the Children’s System of Care) talk to
your program manager for more specific information.

Parolee

On a regular basis, individuals are discharged on parole from California State penal
institutions. In many instances, these persons are in need of mental health services.
Parolees who fall under the Forensic Conditional Release Program (CONREP) will be
provided services in accordance with the current contract between the California
Department of Health Care Services and the County of San Diego. Parolees who are
Medi-Cal beneficiaries and who meet specialty mental health medical necessity
requirements, as specified in WIC 14184.402(A), 14059.5 and Section 1396D(5) of Title
42 of the United States Code, will be provided appropriate Medi-Cal covered mental
health services. Due to the passage of SB 389, MHSA funds may be used to provide
services to persons who meet existing eligibility criteria for MHSA-funded programs and
who are participating in a pre-sentencing or post-sentencing diversion program, to
provide services to persons who are on parole, probation, PRCS, or mandatory
supervision.

NOTES
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REPORTS
ADMISSIONS MORNING REPORT

This report provides a list of clients who have had services from the EPU, ESU,
SDCPH, FFS hospital, or the jail inpatient Units. NOTE: This is a work around until the
enhancement is completed. The current report will print a listing of all the clients by
Unit/SubUnit who had an assignment opened at these facilities for the date range
entered. Therefore only print those pages pertinent to your Unit/SubUnit. Please black
out or detach and shred other Unit/SubUnit information that prints on the report.

To access the template from the Clinician’s Homepage, click on the File Tab >

click “Client Assignments” - click “Client Assignments Reports” - and click

“Client Roster Report”.
£
ﬂ @e View
EO:;) Open . -
pp.yg;.ma o
E’,‘. Security
ﬂ About CCEH

" Client Profile

" Scheduler

Recently Opened Views

e

CLINICIAN'S HOMEPAGE (TRAIN) 235.2.0.0

& =5

_q: Services /s System eRx not available

i

= en I

I Pharmacy Break The Layoutand
Directory Glass Filters =

sroup Motes ePrescribing Status Pharmacies Break Glass Panel Options

" Client Assignments

)

“ | } Client Assignments Maintenance

" Client Financial Infarmation

" Client Reviews

" Client Services

AT

click on “Client Assignments”,

' } Client Treatment Sessions Maintenance

i Client Categories Maintenance

} Assignment Current Server History Maintenance

O,

C 5
g _| Client Roster Report

" Client Assignments Reports

To access the template from the external view, click on the “Home Tab”, select “Menu”, then
Client Assignments Reports”, then “Client Roster Report”.

CCBH Central Training (Staff: STAFF ADMIN)

Ta Clear Global Client s B
b I 4 n @
Client Client Batch Menu
Search Profile = | Monitor ~ =
Global Client Batching Application Menu
" New Client " Client Profile
i Client Assignments Maint | 2cheduler

' (Client Assignments

} Client Assignments Maintenance

" Client Einancial Information

" Client Reviews

" Client Services

ATP

g } Client Treatment Sessions Maintenance

g } Client Categories Maintenance

r } Assignment Current Server History Maintenance 5

@ ‘” i Client Roster Report |
Ll

" | " Client Assignments Reports
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Client Roster Report (Show Access)

Selectionsl | Selectionz? I Selectionzd | Selectionzd I Frint Columns | Sort/Subtotal/Title |

Clierts |21

Client Status |A"

Units | Al

SubUnits | Al

Pragram Category Headings | Al
Program Categories | Al

Unit Types | Al

Administrative Groups | Al

Assignment Types Al
Agzignment Servers Al
Treatment Teams | A
Treatment Team Leaders | &l

Abgence Types Al

rd

155 | « [

%Clear = Load Eatch

& Print il Exit

Highlight “Admissions Morning Report” from the template list and select “Load”.

Load Template for Client Roster Report =

AB 109 5 Subunit rozster 03052016
AB109 MANAGEMENT REFPORT 120772001

Dezcription Created On Created ...

Last Uzed ~
12771 09/25/2019
4355 12/08/2017

33124212022

I ddmizsions Moming Feport i0es24/2000
PTISDETICal FTogram T oter e a7 2003

Bad Address Template

CATEMPATEST

COMNSERY REF PIT

CRISIS RESIDEMTIAL MANAGEMENT REPQI 07110/2014
Cazeload Roster by Sublnit and Server 060442009

a0 Terdaddlles
8397 /072021
432 121042018
10633 051042013
10633 10408/ 2020
33 0BA18/2021 "

(3 Find

= Load

il[aﬂcel
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Selections 1 tab is preset. Do NOT enter Unit and SubUnit.

Client Roster Report (Show Access)

Selections] | Selections2 | Selections | Selectionss | Prirt Columns | Sort/Subtatal/Title |

Clientz | B
Client Status |-"—"-”
Uriits | Al

SubUnits | All
Program Category Headings | All

Program Categories | All
Urit Types |40,50,60,95,101,102

Administrative Groups |4l

NON-CONTIG

Azzignment Types |4l
Azzignment Servers | All

Treatrment Teamns |4

Treatment Team Leaders | &l

) R R

Abzence Types |Al

S Clear (& Lload {DBatch SHPrint x| Exit

On Selection 2 tab, enter the one day date (previous day) in the “Assignments
with Date Opened from and thru” field. For programs closed on weekends and
running the report on Monday morning, select the dates to cover the weekend
dates.

Client Roster Report (Show Access)

Selections] I Selections2 ISeIections§ I Selectionsd I Pritat Colunns I SortAS ubtatal/ Title |

[ssigrments with D ate Opered from | 01 /01 /2023 1 /1242023

Azzignments with D ate Closed from |/ / thru I
Azzignments which were Open [in effect] from | / / thiru A
Assignments which are Currently IO} () Open ) Clased
Include Assignments @ al () Primary Only

[ Only Assigrments with Inactive Servers
[] Report for Foom/Bed Assignments Only
Print all of & Client's Szsignmentz if the Client is included on report

Assignments with or without 3 Home Provider OF (O with (O withOut
Home Provider | &l g
Home Provider Type | A&l E

S Clear [ Load Eatch x| Exit
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The other tabs are pre set.

Select “Print” to print the report.

The “Print Destination” screen will appear.
Select “Default (Printer/Screen)” to preview the report prior to printing. Click

Print Destination

(iOK”.

(w0 efault (Frinter/S creent
{)WPE File [WFE]

() Teut File

() C5V File

File M ame:

OF.

Cancel

Entry

NOTES
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CLIENT TRACKING WITH SUB-UNIT, NAME AND PHONE

This report lists a client’'s home phone number, DOB, SSN, Unit, SubUnit, SubUnit
Description, SubUnit phone number, server number, server name, assignment open
dates, assignment closed dates, last service date, primary SubUnit, and count.

e To access the template from the external view, click on the “File Tab”, select “Menu”,

then click on “Client Assignments”, “Client Assignments Reports”, then “Client Roster
Report”.

= CCBH Central Training (Staff: STAFF ADMIN)

[ 1)

3 5 Clear Global Client e ==

q P x| ear obal len ] Q @
¥

Client Client Batch Menu

Search Profile~  Menitor ~ it
Global Client Batching Application Menu
' New Client .l Client Profile

B Client Assignments Mainte .I Seheduler g
.l Client Assignments @ | EZ Client Assignments Maintenance
.l Client Einancial Information - EB Client Treatment Sessions Maintenance
.I Client Reviews d E_/j Client Categories Maintenance

_.I Client Services 4 EZ Assignment Current Server History Maintenance @

.l ATE 4 | .‘ Client Assignments Reports @ 4 |tl:.| Client Roster Report |

e Select “Load” on the “Client Roster Report” window.

C Client Roster Report (Show Access) = E =
Selections] | Selections2 | Selections3 I Selections4 | Frint Calumng | Sort/Subtotal/Title |
Clients | E
Client Status |AII -
Uniits | &1 [
Sublnits |4 &
Program Categary Headings | Al ﬂ
Frogram Categories |All ﬂ
Urit Types Al 1]
Adminigtrative Groupz | All E
Azzignment Types | Al -
Assignment Servers | All E
Treatment Teams | Al m
Treatment Team Leaders | Al E
Abzence Types |All E
P
S Clear | & Load (DBatch SPrint  x|Exit
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e Highlight “Client Tracking With SubUnit Name and Phone” from the template list
and select “Load”. You may need to use the scroll bar on the right to locate it.

Load Template for Client Roster Report =

D ezcription Created On Created ... LaztUzsed  »
CHATEMPWTEST 12/03/2018 432 121102018 l
COMSERY REFRIT 05/08/2014 10633 051052019
CRISIS RESIDEMTIAL MAMAGEMEMT REPOR 071042014 10633 104082020
Cazeload Roster by Sublnit and Server 06/04,/2009 33 06/13/204
Cenzuz Report for 24 Hour Programs. 06/04,/2009 3302852019
Client Azzignment Tracking Repart 02/04/2011 I 12232022
Client Dizcharge Report 07072009 35 0707204

|Elient Tracking With SUBUIRt Mame and Phone 027087207 1 | f— o []/20/20 21
Llents Dizcharged Dunng Lake Hange U0 33 0510213
(3, Find ZLload | _x|Cancel

e On Selections 1 tab, enter the client's CCBH number or name (LAST, FIRST), in
the “Clients” field.

[ o Client Roster Report (Show Access) - =
Selections I Selections2 I Selectionz3 I Selections4 I Frint Columns | Sort/Subtotal/Title |
Clients | 3CLIEMT, FAKE g']
Clignt Status |-":"-"

Units | =l
Sublnits |4l [+
Program Category Headings |All EI
Frogram Categones | all E
Unit Types |4l (1]
Adrninigtrative Groups [All EI

Azsignment Types & - Admitted Assignments -|
Lizzignment Servers Al EI
Treatment Teams |All E
Treatment Team Leaders | Al E
Abeence Tupes |All EI

M Clear [ Load f2Batch | &Print | x|Exit
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Select “Print” to print the report.
The “Print Destination” screen will appear.
Select “Default (Printer/Screen)” to preview the report prior to printing. Click

“OK”.

(@) Default (Printer/Screent
()WPE File [ VFPE]

() Test File

O CSY File

File Mame:

k. Cancel

NOTES
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ALPHABETICAL PROGRAM ROSTER

This report provides an alphabetical listing of all open clients by SubUnit. This report
can also provide an alphabetical listing of all open or closed clients within a specified

date range.

e To access the template from the external view, click on the “File Tab”, select “Menu”,

L]

then click on “Client Assignments”, “Client Assignments Reports”, then “Client Roster

Report”
o= ‘CCBH Central Training (Staff: STAFF ADMIN)
()
3 [z Clear Global Client ] Q B
®§ iy ¥
Client Client Batch Menu
Search Profile * | Manitor = -
Global Client Batching | application Menu
! New Client ' Client Profile
l 3 Client Assignments Mainte | Scheduler g
| ' Client Assignments @l } Client Assignments Maintenance
| Client Einancial Information d 3 Client Treatment Sessions Maintenance
' Client Reviews } Client Categories Maintenance

' Client Services > } Assignment Current Server History Maintenance @
' ATE 4 | ' Client Assignments Reports G) |t";l Client Roster Report |

e Select “Load” on the Client Roster Report window.

Client Roster Report (Show Access)

Selections] | Selections2 | Selechons3 I Selectionsd I Print Columns | Sort/Subtotal/Title |

Clients

rits

Sublrits

Program Categony Headings
Program Categories

Unit Types

Adrministrative Groups
Azsignment Types
Agzignment Servers
Treatment Teamns
Treatment Teamn Leaders

Abzence Tupez

Client Status |-é't"

i1 o
-
Al @l
Al @l
Al &l
Al @l
Al &l
Al &l
A -
Al &l
Al 21}
Al @l
Al &l

/
S Clear | (& Load {DBatch  &Print  x|Exit
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¢ Highlight “Alphabetical Program Roster” from the template list and select “Load”.

Load Template for Client Roster Report =

D'escription Created On Created ... LastUszed  »
A8 109 5 Suburit roster 03/05/2016 12771 09/25/2019

#B109 MANAGEMENT REPORT 12/07/2011 4855 12/08/2017
s | __13/24/2010 33 01/19/2023
per04s2009 33 12/23/2022

,-'l'n.lphal:uetu:alPrngramﬂnster

3 EEREIEE | 040742073 8987 01/07/2021
CATEMPYTEST 1240352018 4821210/2M8
COWSERY REFP PIT 05/02/,2014 10633 05/10/2019
CRISIS RESIDEMTIAL MAMAGEMEMT REPOR 07/10/2014 10633 1040872020
Caseload Roster by Sublmit and Server 04042003 33 06182021

(3 Find | @load | x|Cancel

e On Selections 1 tab, enter Unit and SubUnit.

Client Roster Report (Show Access)

Selections1 ISeIectionsg I Selections3 I Selectionsd I Prirt Colurnnz I SortSubtotal/Title |

Clients B
Clignt Status |-"3-||
Units | Enter your Unit here
Sublnits | Enter your SubUnit here

Program Category Headings | All

Program Categories | All
Urit Types Al
Administrative Groups | All

-

Assignment Types A - Admitted Assighments
Agsignment Servers | Al

Treatrent Teams |4l

Treatment Team Leaders | Al

15 <« « [

Absence Types Al

M Clear & Load (DBatch  SpPrint  x|Exit
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Selections 2 tab is pre-set for open cases on the current date. No selections are
required unless, a specific date range and/or “All” or “Closed” cases are needed.
When “All” or “Closed” cases are desired, select the appropriate Radio button.

C Client Roster Report (Show Access)

— W= =

|Selecti0nsl I Selections2 I Selections3 | Selections4 I Frint Columns I Sort/Subtotal/ Title |

Assignments with D ate Opened from | TN thiu o
Agsignments with D ate Clozed from |/ / thiu £
Azsighments which were Open [in effect] from | / thiu I
Assignments which are Curently Oal (®) Open () Clased
Include Assignments ® al (2 Primary Only

[ Orly Assignments with Inactive Servers
[]Report for Room/Bed Assignments Only

[ Prirt all of a Client's Assignments if the Client is included on repart

Azzignments with or withaut a Home Provider ® Al (Owith (O withOut
Horme Provider | &l E
Home Pravider Type | &1 E
S Clear (& Load & Batch x| Exit
* For a caseload count as of today leave all dates blank.
or
* For new cases opened in a specific month, enter the date range for that

month in the “Assignments with Dates Opened From” fields.

or

* For cases closed in a specific month, enter the date range for that month in

the “Assignments with Date Closed” fie

or
Eor | of all previ l n
o entc [1C Al rarngyc

Open (in effect from)” field.

Select “Print” to print the report.
The “Print Destination” screen will
appear.

Select “Default (Printer/Screen)” to
preview the report prior to printing.
Click “OK”.
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Print Destination

(@) Tiefault [Printer/S creent
(_JWPE File [WPE)

() Text File

() C5Y File

File Mame:

(] Cancel
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CASELOAD ROSTER BY SUBUNIT AND SERVER

This is a case load report that will list a specific SubUnit’s caseload sorted by server
with page break between servers. To remove the “page break” go to the
“Sort/Subtotal/Title” tab and remove the check mark in the “Pagebreak” column after the
“Assign Server”. The “Pagebreak” can also be removed after the “SubUnit”.

e To access the template from the external view, click on the “File Tab”, select
“‘Menu”, then click on “Client Assignments”, “Client Assignments Reports”, then

“Client Roster Report”.

c CCBH Central Training (Staff: STAFF ADMIN)
03 S5 Clear Global Client ] Q = |
Ly k
Client Client Batch Menu
Search Profile ~ | Monitor = i
Glabal Client Batching Application Menu
' New Client _ Client Profile
3 Client Assignments Mainte ‘I Scheduler

" Client Assignments

" Client Financial Information

" Client Reviews

" Client Services

e

@ | Ez Client Assignments Maintenance
" Ez Client Treatment Sessions Maintenance
g m Client Categaories Maintenance
4 m Assignment Current Server History Maintenance @
r | " Client Assignments Reports G.) 4 |t‘-‘;1 Client Roster Report |

o Select “Load” on the Client Roster Report window.

] Client Roster Report (Show Access) - s
Selections1 | Selections2 I Selectionz3 I Selections4 I Frint Columns I Sort/Subtotal/Title |
Clients |H E
Cligrt Status |-"1"-" - |
Urits | 4 =l
Sublinits | Al =]
Frogram Category Headings | All E
Program Categories | All E
Unit Types | &l 1]
Adminiztrative Groups |All El
Azsignment Types Al -|
Azzighment Servers | All E
Treatment Teams | All E
Treatment Team Leaders Al E
Abzence Typesz All E
o
% Clear = Load Eatch %Erint ll
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Highlight “Caseload Roster Report by SubUnit and Server” from the template list
and select “Load”.

Load Template for Client Roster Report =

Dezcription Created On Created ... Last Used ~
AB 1095 Subunit roster 02/05/2016 12771 08/25/2019
AB109 MANAGEMENT REPORT 12072011 4358 12082017
Admizzions Morning Repart 03/24/2010 33 MA9/2023
Alphabetical Program Foster 06042003 3 MAM92023 _
Bad Address Template 1040772013 8337 A07/2021 =
CMTEMPATEST 12/03/2018 482 1210/2018
COMSERY REF PIT 0540372014 10633 051042019
CRISIS RESIDEMTIAL MAMAGEMERNT REPOI 07/0/2014 10633 100842020
iCaseload Roster by SubUnit and Server 33 0641842021 W

QEind = Load EICaﬂcel

Client Roster Report (Show Access)

Selectionz] ISeIectionsg I Selections3 I Selectionsd I Frint Columns I Sort/Subtotal/Title |

Clients |2
Client Status |J"-"-||
Unitz | Enter your Unit here
SubUnits | Enter your SubUnit here

Program Category Headings | Al

Program Categarigs | Al
Unit Types Al
Administrative Groups | Al

2 o R P P R

Aezignment Types |4 - Admitted Assignments [
Agzighment Servers [all
Treatment Teams | &l
Treatment Teamn Leaders | &l
Abzence Tepes [l
MClear [ load {DBatch  ShPrint  x|Exit
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e Selections 2 tab is pre-set for open cases on the current date. No selections are
required unless, a specific date range and/or “All” or “Closed” cases are needed.
When “All” or “Closed” cases are desired, select the appropriate Radio button.

= Client Roster Report (Show Access) = E =

|Eelecl|nns1 ‘I Selections2 IEeIechnnsI_} | Selectionsd I Frint Calumns I SgltﬁSuhtntal!T\tlel

Assignments with Date Opened from | [ thru £
Azzignments with Date Closed fram | /7 thru L
Aszignments which were Open [in effect] rom |/ / thru s
Aasignments which are Curmently ® (O Open () Clased
Include Assignments ® Al () Primnary Only

[] Only Assignments with Inactive Servers
["] Repart for Aoom/Bed Assignments Only
Frint all of a Client's Assignments if the Client is included on report

Assignments with or without & Home Provider ORI O with (O withOut
Home Provider | Al EI
Home Provider Type | Al EI

S Clear  (Fload (i Batch x| Bt
* For a caseload count as of today leave all dates blank

or
* For new cases opened in a specific month, enter the date range for that
month in the “Assignments with Dates Opened From” fields.

or
* For cases closed in a specific month, enter the date range for that month in
the “Assignments with Date Closed” fields

or
For | of all previ | n nd new n in ifi

month enter the date range for that month in the “Assignments which were
n (in eff from)” field.

* Select "Print” o print the report

e The “Print Destination” screen will

(®)iiafault [Printer/S creent appear.
g¥:5 e Ve e Select “Default (Printer/Screen)”
() CSY File to preview the report prior to
printing. Click “OK”.
File Mame:

Note: Programs usually run this report monthly
after the previous months data entry has been
oK Cancel completed. However this report can be run
anytime.
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BHS-025 CLIENT CHANGE REQUESTS

e Login to the Optum website with your username and password
e Click on BHS Provider Resources - MHP Provider Documents = Forms

e Download the form fills needed

*Please note these forms MUST be typed.

BHS-025 FORM A AND B JOB AID

Form A- to be used to request changes to the following*:
Name (Sort name, Last Name, First, Middle Name)
DOB (date-of-birth)

SSN (social security number)

Sex (Gender)

Medi-Cal Policy Number /Effective Date

DB NS

*Users should NOT make
changes to Name, DOB, SSN,
and Sex when creating a
Demographic Form.

Form B- to be used to request two medical record numbers, for the same person, to be

How to Find Core Client Information (CCI):

combined.

1. Search for desired client in CCBH.

2. Once in the client’s chart RIGHT click on clients DOB, a small window will pop up.

3. Select “Show Core Client Information.”
2 FAKE 3CLIENT Male Born: 05/01/1999

Face Sheet

County of San Diego Mental Health Services
FACE SHEET
Hik Entry Date of Death, if known | 2 2

SAFETY ALERTS

_74 -

@&, Client Search

-

g Client Clear

Add Client

Show Core Client Information I

m =L1 “LJ

Refresh Pane Content
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4. The CCI will display.

Core Client Information Maintenance Panel (TRAIN)

File Core Client Information
™
& [
Refresh Close
Panel
Refresh | Actions Close
2]
9
g Sort Name | 3CLIENT, FAKE Caze Mumber [0 or blank for Auto Aszign]
g Lazt Mame | 3CLIEMT B Fig FAKE Middle M ame
2 oos 05/011933 | © SocSect E Ethricity | Dominican Sex [ | B
g Address B Home Phione
S Ciy PACIFIC GROVE Ca | 93950 ok Phone H
Address County | Monterey Residence County | Maonterey
Client Type (@

How to Complete BHS-025 Forms:
1. Section #1-Requester Information: Should be completed for BOTH forms. All sections
should be completed. The Requester is the person completing the form.

2. Section #2-Client Information:
For Form A “Client Record” column should be completed as data appears in Core Client
Information (CCI). In “Change Client Record TO” column ONLY fill in the sections that
need to be changed.

For Form B “Client Record A” and “Client Record B” columns should both be completed as
data appears in CCI.

To find Medi-Cal Policy # and effective date click on “Insurance Coverages” tab on bottom
of page.

Columns should be completed using the CCI (See How to Find CCI instructions above).
Columns are completed from TOP to BOTTOM. DO NOT USE DEMOGRAPHIC FORM
OR FACE SHEET.
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Live Well, San Diego! : p :
e it County of San Diego-HHSA-Behavioral Health Services

CHANGE/ADDITION of Client Information Form
Fax Form to Health Information Managemen; Services (HIMS) @ (619) 399-3503

For assistance call: Optum Help Desk (800) 834-3792 or HIMS (619) 692-5700 x3
REQUESTER:
s Use Form A to request CHANGES/CORRECTIONS to the Core Client Information (CCI), DEMOGRAPHIC
FORM, and/or CLIENTS 3RD PARTY COVERAGES only.
« Only TYPED Forms will be accepted effective 05/15/2019.
s+ Complete fields in each column as instructed.
» Fax this form along with any supporting documents e.g. ID, Medi-Cal card, Immigration, Adoption.
*Medical Policy & Effective date can be found in Clinicians Homepage “Insurance Coverage"” Tab

Section #1 - REQUESTER INFORMATION

Form

A

Date of Request i1 T Form completed
by:
Program Name Your Phone # | ( ) - Ext #
Unit/SubUnit # / Your Fax# | ( ) -

Section #2 - CLIENT INFORMATION
Client Record

CCl Data Fields- To find Change Client Record TO:

CCl - Right click on pa-
tient name. select “Show

Core Client Information”

As Data CURRENTLY APPEARS in the

Core Client Information (CCI) window
Leave field blank if data not available

Complete ONLY fields that need to be
changed
(Exactly as it should be entered in CCI)

Case Number

Sort Name

Client Name

Date of Birth
(mm{ddlyyyy)

Sex/Gender

i N /I
DFemaIe D!‘dale DDther Dﬂnknuwn D Female

Social Security # - -

*Medi-Cal Policy #leff
date (mm/ddlyyyy)
Remarks /
Additional Information

STOP — DO NOT ENTER INFORMATION BELOW THIS LINE. HIMS USE ONLY.
[C] NOTICE TO REQUESTER:
Unable to confirm change should be made

CLIENT INFORMATION TO BE KEPTIN CCBH

Date of Birth
(mmiddiyyyy)

Social Security # - .
Medi-Cal Policy #

DMaIe

Reason:

Case Number

CCBH Sort Name

Client Name Iaff date !
Date completed by /I / HIMS Staff CCBH ID # and
HIMS Name
HHSA: BHS-025 FORM A [rev 472021 ONFIDEMTIA
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Fax Form to Health Information Management Services (HIMS) @ (619) 399-3503

For assistance call: Help Desk (800

County of San Diego-HHSA-Behavioral Health Services

DUPLICATE CLIENTCASEN

834-3792

ol )

Entry

Form

UMBER

or HIMS (619) 692-5700 x3

REQUESTER:

Use Form B to request duplicate client case numbers to be combined.

Only TYPED Forms will be accepted effective 05/11572019.

Complete fields in each column as instructed.

Fax this form along with any supporting documents e.g. 1D, Medi-Cal card, Immigration, Adoption.
*Medical Policy & Effective date can be found in Clinicians Homepage “Insurance Coverage” Tab

Section #1 - REQUESTER INFORMATION

Date of Request /

/ Form completed

by:

Program Name

Your Phone #

—
—
|

Ext#

Unit/SubUnit #

Your Fax #

—
—
|

Section #2 - CLIENT INFORMATION

CCl Data Fields- To
find CCI - Right click
on patient name,
select “Show Core
Client Information™)

Client Record A
As Data CURRENTLY APPEARS in the

Client Record B
As Data CURRENTLY APPEARS in the

Core Client Information (CCl) window

Core Client Information (CCI) window

Leave field blank if data not available

Leave field blank if data not available

Admin Data |

Case Number

Sort Name

Client Name
Date of Birth

(mmiddiyyyy)

Social Security #

*Medi-Cal Policy
#leff date

(mmiddlyyyy)
Remarks! Add'l

Information

D NOTICE TO REQUESTER:
Unable to Combine Clients

STOP — DO NOT ENTER INFORMATION BEL OW THIS LINE. HIMS USE ONLY.

Reason:

CLIENT INFORMATION TO BE KEPT IN CCBH

Case Number

Date of Birth f

Sort Name

Social Security # =

Client Name

Medi-Cal Policy

# leff date /i
Date completed by / HIMS Staff CCBH 1D #
HIMS and Name
[[] Sent to ASO [[] Sent to MHBU CINiA
inistrative Services Organization [A50) staff only.

Date ASO Combined ; AS0 Staff who Combined
Clients Clients

HHSA: BHS-0Z25 FORM ey, 42021 ONFIDENTIA
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Entry

TRAINING TIP SHEET

1. WHEN YOU GO BACK TO YOUR PROGRAM:
You are learning how to enter assessments in the “SDC Train CCBH”
environment during this training, which is for practice purposes only. It is
important to enter all of your assessment information in the “SDC Live CCBH”
environment when you return to your program.

2. SUPPORT DESK — IMPORTANTL
Please do not try to solve issues by “working around” the system. You are to
enter data as required and you must call the Support Desk for any questions.

The Support Desk contact information is:

800-834-3792
sdhelpdesk@optum.com

3. EOR ONLINE USER MANUALS AND FORMS: (including forms and form-fill versions of
assessments for “emergency” situations) go to the Optum website below and follow
these instructions:

https://www.optumsandiego.com

Click "Register" to get an on-line form for your personal login.
Confirm your email address.

When you have access, click “Login”.

Login with your User Name and Password.

Go to "Secure Documents".

Select CCBH (formerly Anasazi) Secure Documents

Click "Forms" or "Manuals".

4. TOREGISTER FOR ADDITIONAL TRAINING:

www.regpack.com/reg/optum

5. HIPAA REGULATIONS FOR TRAINING: There is actual client data (names, etc.) in the
training environment. HIPAA regulations mandate this information be treated
confidentially.

6. NON-USE OF CCBH ACCOUNT: Inactive accounts pose a security risk by allowing an
opportunity for unauthorized access. Therefore, in order to safeguard protected health
information, inactive accounts will be closely monitored. Users who have not used CCBH
in 90 days will have their account deactivated.
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Entry

Support Desk Contact Information
sdhelpdesk@optum.com
1-800-834-3792

Monday through Friday (E-mail

Services
6:00 am to 6:00 pm All services except password resets or any service involving PHI
Monday through Friday (Telephone
Hours Services

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages*
6:00 am to 6:00 pm All services

6:00 pm to 11:00 pm | Resetting passwords (24 hour programs) and reporting system outages*
11:00 pm to 4:30 am | Reporting system outages*

Weekends (Telephone
Hours Services

4:30 am to 11:00 pm | Resetting passwords (24 hour programs) and reporting system outages*
11:00 pm to 4:30 am | Reporting system outages*

* By definition, a system outage affects multiple users. Examples include when:
-The system does not respond and appears to be frozen
-No data can be entered or viewed

Support Desk Suggestions

¢ Please consult with your program manager and your resource packet prior to
contacting the Support Desk.

e When calling for a password reset on weekdays between 4:30-6a or 6-11p, or
calling weekends between 4:30a-11p, you must leave a message. Include your
name, CCBH staff ID, phone number and the reason for your call.

¢ You may be given a ticket/tracking number if you call between 6:00a and 6:00p
Monday through Friday. Remember to keep this number for future reference.

Additional Contacts

Questions Where To Go

Clinical Documentation Questions Documentation Manual/Your Program Manager
Duplicate Clients and Complete Form BHS-025 and
Name/DOB/Gender/SSN Changes Call Medical Records: 619-692-5700 x 3
Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612 Fax- 858-467-9682
Online User Manuals and Forms www.optumsandiego.com

Service Codes CCBH (Anasazi) User Manual/QM Unit
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